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1 Overview

If you want to use a private BMS image, you can use an external image file to create one. This
document describes the private image creation procedure (including creating a VM and
installing the OS, software, and drivers on the VM) and uses multiple OSs as examples to
provide instructions for you to create a private image. You can also install software as needed
to customize your private image.

After you have created a private image, you need to register it on the cloud platform. For
details, see section Registering a Private Image. After successful registration, you can select
this private image when applying for a BMS.

Image Creation Process
Figure 1-1 shows the process of an image creation.
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Figure 1-1 Process of image creation

NOTE

Currently, only ZVHD images are supported. After obtaining an image file, you need to convert its
format to ZVHD.

OS List

The BMS image supports the following OSs:

Table 1-1 OS list

OS Type OS Version Kernel version

RedHat RedHat Linux Enterprise 6.5
64bit

2.6.32-431.el6.x86_64

RedHat Linux Enterprise 6.7
64bit

2.6.32-573.el6.x86_64

RedHat Linux Enterprise 6.8
64bit

2.6.32-642.el6.x86_64

RedHat Linux Enterprise 6.9
64bit

2.6.32-696.e16.x86_64
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OS Type OS Version Kernel version

RedHat Linux Enterprise 7.0
64bit

3.10.0-123.e17.x86_64

RedHat Linux Enterprise 7.2
64bit

3.10.0-327.e17.x86_64

RedHat Linux Enterprise 7.3
64bit

3.10.0-514.el7.x86_64

RedHat Linux Enterprise 7.4
64bit

3.10.0-693.e17.x86_64

SUSE SUSE Linux Enterprise
Server 11 SP4 64bit

3.0.101-63-default

SUSE Linux Enterprise
Server 12 SP1 64bit

3.12.49-11-default

SUSE Linux Enterprise
Server 12 SP2 64bit

4.4.21-69-default

SUSE Linux Enterprise
Server 12 SP3 64bit

4.4.73-5-default

Oracle Linux Oracle Linux Server release
6.8 64bit

4.1.12-37.4.1.e16uek.x86_64

Oracle Linux Server release
6.9 64bit

4.1.12-61.1.28.e16uek.x86_64

Oracle Linux Server release
7.2 64bit

3.10.0-327.e17.x86_64

Oracle Linux Server release
7.3 64bit

3.10.0-327.el7.x86_64 or
4.1.12-61.1.18.e17uek.x86_64

Oracle Linux Server release
7.4 64bit

4.1.12-94.3.9.e17uek.x86_64

EulerOS EulerOS 2.2 64bit 3.10.0-327.44.58.35.x86_64

CentOS CentOS 6.8 64bit 2.6.32-642.e16.x86_64

CentOS 6.9 64bit 2.6.32-696.e16.x86_64

CentOS 7.2 64bit 3.10.0-327.e17.x86_64

CentOS 7.3 64bit 3.10.0-514.el7.x86_64

CentOS 7.4 64bit 3.10.0-693.e17.x86_64

CentOS 7.4 for ARM 4.11.0-22.el7a.aarch64

Ubuntu Ubuntu 16.04 LTS 64bit 4.4.0-21-generic x86_64
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OS Type OS Version Kernel version

Ubuntu 16.04.3 Server-
ARM 64bit

4.10.0-35-generic
NOTE

l The SDI driver is not
supported.

l The BIOS version of the
Taishan 2280 server must be
1.29 or later.

Ubuntu 14.04 LTS 64bit 3.13.0-24-generic

Windows Windows Server 2012 R2
64bit

-

Windows Server 1709 64bit -

Windows Server 2016 64bit -

 

NOTE

The SDI driver only supports the preceding kernel versions (for Ubuntu 16.04.3 Server-ARM 64bit, the
SDI driver is not supported). When downloading the SDI card driver, ensure that the driver matches the
kernel version.

You can run the uname -r command to query the OS kernel version.
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2 Preparing the Environment

l Obtain a Linux physical server or virtual machine used for creating the image (this is the
host), and install Linux on the host.
You must select Server with GUI and a virtualization environment during the OS
installation. The following figures show the window for installing CentOS 7.3 64-bit.
Select Server with GUI, FTP Server, Virtualization Client, Virtualization
Hypervisor, and Virtualization Tools.

When creating an ARM 64 image, you are advised to install Ubuntu 16.04 Server-arm64
and select HWE kernel shown in the following figure.
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After the host OS is installed, run the following command to install the ubuntu desktop
and virtualization software, and restart the OS to make the installation take effect:

sudo apt-get update
sudo apt-get dist-upgrade
sudo apt-get install ubuntu-desktop
sudo apt-get install qemu
sudo apt-get install qemu-kvm
sudo apt-get install libvirt0
sudo apt-get install virt-manager
sudo apt-get install qemu-efi

l Configure the host network and remote connection.

a. The host must connect to the Internet so that you can install software online on
VMs through the host.

b. To connect to the host from a Windows PC, configure the remote connection.

l Enable the vsftpd, sshd, and VNC services and configure the services. For details, see
chapter Configuring the SSH Service, Configuring the vsftpd Service and
Configuring the VNC Service.

This enables you to remotely transmit software packages, ISO image files, and scripts to
the host, and remotely connect to the host.

l For CentOS 7.x, run the following commands to disable the firewall so that you can log
in to the host using VNC Viewer:

systemctl disable firewalld.service
systemctl stop firewalld.service

l Upload required files to the host.

After the configuration is complete, use the vsftp service to upload the files required by
VMs to the host. After this, the host environment configuration is complete. If you use
Xftp to upload the files, click the icon shown in the red box in the following figure after
you log in to the host through Xshell using SSH.
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3 Creating a Linux Image

3.1 Preparing Required Hardware and Software
Obtain a Linux physical server or virtual machine used for creating the image. This is the
host. (prepare a x86 server for creating a x86 image and an ARM server for creating an ARM
image)

The host must have the followings installed:

l vsftpd service
l sshd service
l VNC service
l virt-manager tool
l KVM virtualization software

NOTE

You can download virt-manager from its official website or select it from the OS installation package.

Table 3-1 lists the required software.

Table 3-1 Required software

Software Description How to Obtain

Host ISO image CentOS 7.x You are advised to obtain it
from the official website.

OS ISO file ISO file used for creating an
image. The OSs supported by
BMS image are shown in Table
1-1.

You are advised to obtain
the ISO file from the OS
official website.
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Software Description How to Obtain

SDI card driver
software package

If FusionStorage is used, this
software must be installed on
VMs for shared storage.

Obtain it from the following
OBS bucket:
https://bms-image-
package.obs.myhwclouds.
com/SD100-2.0.0-OS-
V101.zip

bms-network-config
network configuration
software package

Used for automatic network
configuration

Obtain it from the following
OBS bucket:
https://bms-image-
package.obs.myhwclouds.
com/bms-network-
config-1.0.8.zip

qemu-img-hw Used to convert format of images. Obtain it from the following
OBS bucket:
https://bms-image-
package.obs.myhwclouds.
com/qemu-img-hw.zip

Cloud-Init It is installed online. Ensure that
the server used for creating an
image can connect to the
network.

You are advised to obtain it
from the official website.

 

NOTE

During OS installation, ensure that you only select required software packages. If you install a large
amount of software, the created image file will be too large.

The memory of the BMS must be at least 150 MB larger than that of the created image. Ensure that the
created image meets this requirement.

Table 3-2 lists the required tools.

Table 3-2 Required tools

Tool Description How to Obtain

A tool for remote
access across platforms

Used for accessing the host
during image creation, such as
Xshell

You are advised to obtain it
from the official website.

File transfer tool Used for transferring files to the
VM during image creation, such
as Xftp

You are advised to obtain it
from the official website.
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Tool Description How to Obtain

VNC tool Used for logging in to the VM
during image creation, such as
VNC Viewer
NOTE

If VNC Viewer is the 5.3.2 version,
choose Options > Expert >
ColorLevel on the login page and
set ColorLevel to rgb222.
Otherwise, you may fail to connect
to the remote OS.

You are advised to obtain it
from the official website.

 

3.2 Creating a VM
Use virt-manager to create a VM. This section describes how to create an Oracle Linux 6.8
VM. The methods of creating VMs running other OSs are similar.

1. Log in to the host, start the terminal, and run the virt-manager command. The virt-
manager interface is displayed.

2. Download the required ISO image on the host or download the ISO image locally and
use Xshell to upload it to the host.

3. Create a VM. In the New VM window, select Local install media (ISO image or
CDROM).

4. Select an ISO image, its OS type, and version.

5. Configure the VM CPU and memory.

– Memory (RAM): 4096 MiB
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– CPUs: 4
6. Configure the size of the disk image to be created. Select the virtual disk size of the

image based on requirements.

NOTE

l You are not advised to configure a large size, which may result in a large image file. It is
recommended that the Oracle Linux 7.3 or Red Hat 7.3 image should be smaller than 6 GB or
even smaller, as long as it can meet the requirements. For an Ubuntu 16.04 ARM image, select
Select managed or other existing storage, create a 150 GB QCOW2 image, and select the
image.

l The image file size and memory (150 MB) cannot exceed the physical memory size of the
BMS. Otherwise, provisioning of BMSs will fail.

7. Click Manage and select a storage path, for example, /home/h.
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Click , set Name (suffix .img is recommended so that the image can be
decompressed if it is large) and select raw (recommended) for Format.

Click Finish. In the displayed storage volume list, select the created storage volume and
click Choose Volume.
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8. Enter the name of the VM (such as oracle6.8) and select Customize configuration
before install. For an Ubuntu 16.04 ARM image, select NAT in Advanced options.

9. Configure the NIC, select e1000 (Gigabit network adapter), and click Apply. For an
Ubuntu 16.04 ARM image, skip this step.
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10. For a SUSE 12 image and KunLun server for the HANA solution, set the boot mode to
UEFI. In the navigation pane on the left, choose Overview. In the right pane, select a
UEFI mode for Firmware.

11. Click Begin Installation to begin install.
12. Wait for the VM to start and choose Installation. Configure the OS language and time

zone. Select the installation scenario based on requirements. Some OSs, such as SUSE
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and CentOS 7.x, have physical servers, VMs, KVM and Xen. Select the required items
based on service requirements and install an OS.

3.3 Installing an OS on the VM
Install an appropriate OS for the VM. This section describes how to install SUSE 11 SP4,
Ubuntu 16.04, Ubuntu 14.04, SUSE 12, and CentOS 7.4 for ARM because installing these
types of OSs requires some special configuration.

3.3.1 SUSE 11 SP4
1. On the Installation Settings page, click the Expert tab and choose Change >

Partitioning.
Create the swap partition.

a. On the Preparing Hard Disk page, select Custom Partitioning (for experts) and
click Next.

b. In the navigation pane on the left, choose Hard Disks and click Add Partition.
c. On the Add Partition on /dev/sda page, select Primary Partition and click Next.
d. Select Custom Size, enter 10 GB, and click Next.
e. Set Formatting Options and Mounting Options, then click Finish.

Create the boot partition.

a. In the navigation pane on the left, choose Hard Disks and click Add Partition.
b. On the Add Partition on /dev/sda page, select Primary Partition and click Next.
c. Select Custom Size, enter 5.00 GB, and click Next.
d. Set Formatting Options and Mounting Options, then click Finish.
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The swap and boot partitions are created successfully.
2. Complete configurations (create volumes).

If the swap and boot volumes both use the LVM mode, perform the following operations
to create volumes:

a. In the navigation pane on the left, choose Hard Disks and click Add Partition.
b. On the Add Partition on /dev/sda page, select Primary Partition and click Next.
c. Select Custom Size, enter 14.99 GB, and click Next.
d. Select Do not format partition and Do not mount partition, then click Finish.
e. In the navigation pane on the left, choose Volume Management, click Add, and

select Volume Group.
f. Configure required parameters and click Finish.
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g. In the navigation pane on the left, choose Volume Management, click Add, and
select Logical Volume.

h. Set Name to root and Type to Normal Volume, then click Next.

i. Enter 10.00 GB for Custom Size and click Next.

j. Set Formatting Options and Mounting Options, then click Finish.

The root volume is created. The following steps describe how to create the swap
volume:

k. In the navigation pane on the left, choose Volume Management, click Add, and
select Logical Volume.

l. Set Name to swap and Type to Normal Volume, then click Next.

m. Select Maximum Size (4.99 GB) and click Next.

n. Set Formatting Options and Mounting Options, then click Finish.
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Click Accept.
The root and swap volumes are created.

3. On the Installation Settings page, check the partitioning and booting configuration, then
click Install.

4. Click I Agree and then Install.
5. Set the password of user root and click Next.
6. Set Hostname and Domain Name, then click Next.
7. On the Network Configuration page, select Use Following Configuration and click

Next.
On the Test Internet Connection page, select No, Skip This Test.

8. On the Network Services Configuration page ,select Use Following Configuration
and click Next.

9. Retain the default settings on the User Authentication Method page and click Next.
10. Create a local user, such as suse. Then click Next.

NOTE

When installing SUSE 11 SP4, you must create a local user. After the installation is complete, you
can delete it if you do not need it. For details, see step 5 in section Configuring the VM
Environment.

11. On the Hardware Configuration page ,select Use Following Configuration and click
Next.

12. Click Finish.

3.3.2 Ubuntu 16.04 and Ubuntu 14.04
1. Perform the following steps to manually partition the VM disk during installation:
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*Select Primary rather than Logical, as shown in the following figure.

The partitioning result is shown in the following figure.

3.3.3 SUSE 12
1. Click Expert Partitioner before you start partitioning the disk.
2. Select and right-click default partitions shown in the following figure and select Delete.
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3. Partition the disk based on service requirements. The following is an example.

a. In the navigation pane on the left, choose Hard Disks and click Add Partition.
b. Select Primary Partition and click Next.
c. Set the value of Size to 500 MiB (for example) or based on service requirements

and configure Custom Region.
d. Select Operating System for Role and click Next.
e. Set File System and Mount Point. Then click Finish.

The boot partition is created.
4. If the swap and root volumes both use the LVM mode, perform the following operations

to create volumes:

a. In the navigation pane on the left, choose Hard Disks and click Add Partition.
b. Select Primary Partition and click Next.
c. Select Custom Size, enter 19.50 GB for Size, and click Next.
d. Select Operating System for Role and click Next.
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e. Set Formatting Options and click Finish.

f. In the navigation pane on the left, choose Volume Management, click Add, and
select Volume Group.

g. Set parameters and click Add to add available physical volumes to the Selected
Physical Volumes area.
After configuration, click Finish.

h. In the navigation pane on the left, choose Volume Management, click Add, and
select Logical Volume.

i. Set the logical volume name to swap and size to 5 GiB.
j. Select Operating System for Role.
k. Set Formatting Options and Mounting Options, then click Finish.
l. Create the root volume in the similar way as the swap volume. Set the logical

volume name to root and size to 14.50 GiB.
Set Formatting Options and Mounting Options, then click Finish.
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Check the partitions and volumes.

The partitions and volumes are created successfully. Click Next to install the OS as
prompted.

3.3.4 CentOS 7.4 for ARM
1. Select Install CentOS Linux AltArch 7.
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2. Install the OS as prompted.

3. Set the time zone.
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4. Select the software to be installed based on your requirements.
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5. Set the OS password.

6. Enter b and press Enter to start the installation.
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3.4 Configuring the VM Environment
Configure the network environment for the VM so that it can connect to the Internet and
installation packages can be uploaded to it.

Prerequisites
l The host can connect to the Internet.
l You have connected to the host using a remote desktop tool such as VNC Viewer.
l The required installation package has been uploaded to the host.

Procedure
1. Configure the VM network.

Configure an available IP address for the VM so that it can communicate with the host.

a. Run the following command on the VM to query the NIC name:
ifconfig -a

b. Run the following command to check whether the NIC has obtained the IP address:
ifconfig
Information similar to the following is displayed (xxx indicates the IP address
automatically obtained and XX indicates the MAC address):
eth0     Link encap:Ethernet  HWaddr XX:XX:XX:XX:XX:XX
inet addr:xxx.xxx.xxx.xxx  Bcast:xxx.xxx.x.xxx Mask:xxx.xxx.xxx.xxx

c. If the NIC has not obtained the IP address, run the following command to enable
the NIC to dynamically obtain the IP address (otherwise, skip this step):
ifup NIC name
An example is as follows:
ifup eth0
Information similar to the following is displayed:
Determining IP information for eth0... done
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You can also run the following command:
ifconfig eth0 up
No information is displayed.

2. Disable the VM firewall (the firewall prevents remote login using SSH and must be
disabled).
– Run the following commands to disable the firewall of a Red Hat 7.0, Red Hat 7.2,

Red Hat 7.3, Red Hat 7.4, Oracle Linux 7, EulerOS 2.2, CentOS 7.2, CentOS 7.3,
CentOS 7.4, or CentOS 7.4 for ARM VM:
systemctl disable firewalld.service
systemctl stop firewalld.service
Query the status of the service: service firewalld.service status
[root@localhost ~]# service firewalld.service status
Redirecting to /bin/systemctl status firewalld.service
 firewalld.service - firewalld - dynamic firewall daemon
  Loaded: Loaded (/usr/lib/systemd/system/firewalld.service disabled; 
vendor preset: enabled)
  Active: inactive (dead)
   Docs: man:firewalld(1)

– Run the following commands to disable the firewall of a Red Hat 6.7, Red Hat 6.8,
Red Hat 6.9, CentOS 6.8, CentOS 6.9, Oracle Linux 6.8 or Oracle Linux 6.9 VM:
chkconfig iptables off
service iptables stop
Query the status of the service: service iptables status
[root@localhost ~]# service iptables status
iptables: Firewall is not running.

– Run the following commands to disable the firewall of a SUSE 12 VM:
systemctl disable SuSEfirewall2.service
systemctl stop SuSEfirewall2.service
Query the status of the service: service SuSEfirewall2 status

– Run the following command to disable the firewall of a SUSE 11 VM:
rcSuSEfirewall2 stop
Run the yast command and perform the following operations:
Choose Security and Users > Firewall. Check whether Disable Firewall
Automatic Starting is displayed. If yes, click Cancel and then Quit. If no, click
Next, Finish, and then Quit.

– Ubuntu 16.04 or Ubuntu 14.04 has no firewall management service enabled by
default, and you can download the firewall management software ufw at https://
packages.ubuntu.com/.
The deb package is as follows (the version number is only for reference):
ufw_0.35-0ubuntu2_all.deb
Run the following command to disable the firewall:
ufw disable

3. Upgrade the wicked component (only required for SUSE 12 SP1).

a. Run the rpm -ivh --nodeps --force *rpm command to install the wicked software
package forcibly.

b. Check the wicked software packages that have been installed.
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linux-locc:/home/fsp/Desktop # rpm -qa | grep wick
wicked-service-0.6.28-1.1.x86_64
libwicked-0-6-0.6.28-1.1.x86_64
libwicked-0-6-0.6.40-28.6.1.x86_64
wicked-0.6.28-1.1.x86_64
wicked-service-0.6.40-28.6.1.x86_64
wicked-0.6.40-28.6.1.x86_64

c. Uninstall wicked software packages of old versions.
linux-locc:/home/fsp/Desktop # rpm -e wicked-service-0.6.28-1.1.x86_64
linux-locc:/home/fsp/Desktop # rpm -e libwicked-0-6-0.6.28-1.1.x86_64
linux-locc:/home/fsp/Desktop # rpm -e wicked-0.6.28-1.1.x86_64

4. Disable the network management tool of the VM (the network management tool may
conflict with the network-config configuration and must be disabled). Skip this step for
SUSE 11 SP4, Ubuntu 16.04 and Ubuntu 14.04.

– Run the following commands to disable the network management service of a Red
Hat 7.0, Red Hat 7.2, Red Hat 7.3, Red Hat 7.4, Oracle Linux 7, EulerOS 2.2,
CentOS 7.2, CentOS 7.3, CentOS 7.4 VM, or CentOS 7.4 for ARM:

systemctl disable NetworkManager.service
systemctl stop NetworkManager.service
Query the status of the service: service NetworkManager.service status
[root@localhost ~]# service NetworkManager.service status
edirecting to /bin/systemctl status NetworkManager.service
 NetworkManager.service - Network Manager
  Loaded: loaded (/usr/lib/systemd/system/NetworkManager.service 
disabled; vendor preset: enabled)
  Active: inactive (dead) since Mon 2017-11-13 19:06:18 CST; 1 min 17s 
ago

– Run the following commands in turn to disable the network management service of
a Red Hat 6.7, Red Hat 6.8, Red Hat 6.9, CentOS 6.8, CentOS 6.9, Oracle Linux 6.8
or Oracle Linux 6.9 VM:

NOTE

If you select to install the desktop when creating a Red Hat 6.7, Red Hat 6.8, Red Hat 6.9,
CentOS 6.8, CentOS 6.9, Oracle Linux 6.8 or Oracle Linux 6.9 VM, you need to run the
following command to disable the network service. Otherwise, do not run these commands.

service NetworkManager stop
chkconfig NetworkManager off

– Run the following commands to disable the network management service of a
SUSE 12 VM:

systemctl disable wicked
systemctl stop wicked

5. (Optional) Delete the VM local user.

When installing the VM, you need to create a local user. After the installation is
complete, you can delete the local user by running the following command:

userdel -rf xxx
xxx is the name of the local user. The user is deleted successfully if the /home directory
does not contain the folder of the user.

NOTE

If the user is not deleted, restart the VM, log in to it as user root, and run the command again.

6. (Optional) Modify DHCP configuration items.
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NOTE

This operation is required for SUSE Linux. For other OSs, skip this step.

a. Open the command-line interface and run the su - root command to switch to user
root.

b. Run the vi /etc/sysconfig/network/dhcp command to open the target configuration
file using the vi editor.

c. Enter ?DHCLIENT_PRIMARY_DEVICE and press Enter to locate the
configuration item.
Press i to enter editing mode and set the value of this configuration item to yes to
enable DHCP to obtain the default gateway during start.
Press Esc to exit editing mode.

NOTE

If the configuration file does not contain the DHCLIENT_PRIMARY_DEVICE
configuration item, ignore it.

d. Enter ?DHCLIENT_SET_HOSTNAME and press Enter to locate the
configuration item.
Press i to enter editing mode and set the value of this configuration item to no to
prevent DHCP from modifying the hostname.
Press Esc to exit the editing mode.

e. Enter ?DHCLIENT_USE_LAST_LEASE and press Enter to locate the
configuration item.
Press i to enter editing mode and set the value of this configuration item to no to
enable DHCP to obtain IP addresses continuously.
Press Esc to exit the editing mode.

f. Enter :wq and press Enter to save the change and exit.
7. (Optional) For Ubuntu 14.04, you need to set the timeout parameter for the GRUB

configuration file to prevent failure to access the system due to abnormal server power-
off.

a. Use the vi editor to open /etc/default/grub and add
GRUB_RECORDFAIL_TIMEOUT=10 after GRUB_CMDLINE_LINUX.
GRUB_DEFAULT=0
#GRUB_HIDDEN_TIMEOUT=0
GRUB_HIDDEN_TIMEOUT_QUIET=true
GRUB_TIMEOUT=2
GRUB_DISTRIBUTOR='lsb_release -i -s 2> /dev/null || echo Debian'
GRUB_CMDLINE_LINUX_DEFAULT=""
GRUB_CMDLINE_LINUX="console=tty0 console=ttyS0"
GRUB_RECORDFAIL_TIMEOUT=10

b. Run the following command to update the configuration:
grub-mkconfig -o /boot/grub/grub.cfg

8. Upload the required software package to the VM.
– Method 1: If the VM can communicate with the host, run the scp command to

upload the software package to the VM.
This method is recommended. You can query how to use it by running the scp -help
command. An example command is as follows (the following file name is an
example):
scp fsp@xxx.xxx.xxx.xxx:/home/fsp/network-config-1.0-1.x86_64.rpm /home
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NOTE

In the command, fsp is the username, xxx.xxx.xxx.xxx is the host IP address, home/fsp is a
customized directory, network-config-1.0-1.x86_64.rpm is the name of the file uploaded to
the host, and /home is the VM directory.

– Method 2: If the VM can communicate with the host and you can log in to the VM
using Xshell, you can upload the package to the VM using xftp.

– Method 3: If the VM cannot communicate with the host, use the virtual CD-ROM
drive to mount the software package.

Step 1: Create an ISO file on the host.

n Run the mkdir /root/software command to create a directory.

n Place the network-config and SDI card driver software packages in the created
directory.

n Run the cd /root command and then the mkisofs -L -R -J -T -V system-sp2 -
o defindsoftware.iso /root/software command.

n Run the ll command. defindsoftware.iso shown in the command output is the
generated ISO image file.

Step 2: Use virt-manager to mount the ISO image.

i. On the VM, choose View > Details.

ii. Click IDE CDROM 1 and click Connect in the right area. If a disk has been
mounted, click Disconnect.

iii. Click Browse Local and select /root in which the ISO image is created.
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iv. Double-click the created ISO image defindsoftware.iso and click OK in the
displayed dialog box.

v. Choose View > Console and select the VM that is being operated.
vi. Run the lsblk command to check whether the ISO image is mounted, such as

to /run/media/suse/system-sp2.
vii. Run the cd /run/media/suse/system-sp2 command to copy the files in the

directory to another directory, such as /home. If the mount point has no file
directory, you need to run the mount /dev/sr0 /home command to mount the
ISO image file to the /home directory (for example).

3.5 Installing Cloud-Init

Scenarios
Cloud-Init is a VM or BMS initialization tool for setting the network, hostname, and hosts
files for VMs or BMSs to be created using images. This tool can also be used to generate
random passwords for these VMs if needed.

If you do not need to set these parameters or generate random passwords for VMs or BMSs
created using images, Cloud-Init is not required. Cloud-Init has requirements on Linux
versions and can only be installed from the Internet. Therefore, before making a Linux image,
ensure that the Internet is accessible.

Prerequisites
l You have logged in to the VM.
l The host can connect to the Internet.
l You have logged in to the host using VNC and install an OS on virt-namager that has

been started.
l Files in the /etc/yum.repos.d or /etc/zypp/repos.d directory have been backed up for

configuring the yum or zypp source on a VM.
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The backup procedure is as follows:
– Switch to the cd /etc/yum.repos.d or cd /etc/zypp/repos.d directory.
– Check the repo files in the directory. If no repo file exists, skip the next step.
– Run the following command to back up all repo files:

mv /etc/yum.repos.d/xxx.repo /etc/yum.repos.d/xxx.repo.backup
xxx is the name of a file.

NOTE

The package management tool for Red Hat and Oracle Linux is yum, and that for SUSE is
zypper.

Procedure
l The following procedure is only an example. You are advised to download the Cloud-Init

installation package from the official website. The version of Cloud-Init will be updated
with on official website in real time. When installing Cloud-Init, use the latest version
from the official website.

l When modifying the /etc/cloud/cloud.cfg configuration file, ensure that its format is
consistent with the provided example that conforms to the YAML syntax.

3.5.1 Red Hat, CentOS, and Oracle Linux
NOTE

This section describes how to install Cloud-Init for Oracle Linux 6.8 and also its differences from
installing Cloud-Init on other types of OSs.

1. Configure the yum source on the VM, which is used for installing Cloud-Init and its
dependent packages online.
For a Red Hat, CentOS, and Oracle Linux VM, the default yum source can be used. Run
the yum repolist command to update the yum repository.
– If the update is successful, go to step 5.
– If the update fails, download an available image source from http://mirrors.

163.com. For details, see steps 2 to 4.
2. Perform the following operations to back up files in the /etc/yum.repos.d directory:

a. Run the cd /etc/yum.repos.d to switch to the /etc/yum.repos.d directory.
b. Run the ll -h command to check the repo files in the directory.

If no repo file exists, skip the next step.
c. Run the following command to back up all repo files:

mv /etc/yum.repos.d/xxx.repo /etc/yum.repos.d/xxx.repo.backup.
xxx is the name of a file.

NOTE

The package management tool for Red Hat, Oracle Linux, and CentOS is yum.

3. Run either of the following commands to download the image to the /etc/yum.repos.d
directory:
wget -O /etc/yum.repos.d/CentOS6.repo http://mirrors.163.com/.help/CentOS6-
Base-163.repo
curl -o /etc/yum.repos.d/CentOS6.repo http://mirrors.163.com/.help/CentOS6-
Base-163.repo
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NOTE

The package management tool for Red Hat, CentOS, and Oracle Linux is yum. Table 3-3 lists the
yum source addresses for Red Hat, CentOS, and Oracle Linux 7. The alias of files downloaded in
the /etc/yum.repos.d directory can be CentOS7.repo.

Table 3-3 yum source addresses

OS Version yum Source Address

Red Hat, CentOS, and
Oracle Linux

Red Hat 6.5, Red Hat 6.7,
Red Hat 6.8, Red Hat 6.9,
CentOS 6.8, CentOS 6.9, and
Oracle Linux 6.8

http://mirrors.
163.com/.help/CentOS6-
Base-163.repo

Red Hat 7.2, Red Hat 7.3,
Red Hat 7.4, CentOS 7.2,
CentOS 7.3, CentOS 7.4,
Oracle Linux 7.3, and
CentOS 7.4 for ARM

http://mirrors.
163.com/.help/CentOS7-
Base-163.repo

 

4. Run the yum repolist command to update the yum repository.

You may fail to access the yum repository (for example, 404 Not Found is displayed).

In this case, use the vi or vim editor to modify the /etc/yum.repos.d/CentOS6.repo file
and change $releasever to 6. For Red Hat, CentOS, and Oracle Linux 7, change
$releasever in the value of parameter baseurl in the /etc/yum.repos.d/CentOS7.repo
file to 7.

Run the yum repolist command again to update the yum repository.

5. Install Cloud-Init.
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– For Red Hat 6.5, Red Hat 6.7, Red Hat 6.8, Red Hat 6.9, CentOS 6.8, CentOS 6.9,
Oracle Linux 6.8, Red Hat 7.2, Red Hat 7.4, CentOS 7.2, and CentOS 7.3, run the
following command to install Cloud-Init online:
yum install cloud-init

– For Oracle Linux 7.3, run the following command to install Cloud-Init 0.7.5 (you
are advised to download the latest installation package from the Oracle official
website):
rpm -ivh cloud-init-0.7.5-6.0.1.el7.x86_64.rpm
[root@localhost fsp]# rpm -ivh cloud-init-0.7.5-6.0.1.el7.x86_64.rpm 
 warning:cloud-init-0.7.5-6.0.1.el7.x86_64.rpm: Header V3 RSA/SHA256 
Signature, key 
 error: Failed dependencies: 
        PyYAML is needed by cloud-init-0.7.5-6.0.1.el7.x86_64 
        net-tools is needed by cloud-init-0.7.5-6.0.1.el7.x86_64 
        policycoreutils-python is needed by cloud-
init-0.7.5-6.0.1.el7.x86_64 
        python-boto is needed by cloud-init-0.7.5-6.0.1.el7.x86_64 
        python-cheetah is needed by cloud-init-0.7.5-6.0.1.el7.x86_64 
        python-jsonpatch is needed by cloud-init-0.7.5-6.0.1.el7.x86_64 
        python-prettytable is needed by cloud-
init-0.7.5-6.0.1.el7.x86_64 
        python-requests is needed by cloud-init-0.7.5-6.0.1.el7.x86_64 
During the installation, you will be asked to install the preceding dependency
packages. Run the yum install Package name command to install the packages, for
example, run the yum install PyYAML command. When message Is this ok [y/d/N]
is displayed, enter y to install a package.
After installing all dependency packages, run the following command again to
install Cloud-Init:
rpm -ivh cloud-init-0.7.5-6.0.1.el7.x86_64.rpm

– For Red Hat 7.3, run the following command to install Cloud-Init 0.7.9 (you are
advised to download the installation package from the Red Hat official website):
rpm -ivh cloud-init-0.7.9-4.el7.x86_64.rpm
[root@localhost yum.repos.d] # rpm -ivh cloud-
init-0.7.9-4.el7.x86_64.rpm 
 warning:cloud-init-0.7.9-4.el7.x86_64.rpm: Header V3 RSA/SHA256 
Signature, key 
 error: Failed dependencies: 
        PyYAML is needed by cloud-init-0.7.9-4.el7.x86_64 
        pyserial is needed by cloud-init-0.7.9-4.el7.x86_64 
        python-jinja2 is needed by cloud-init-0.7.5-6.0.1.el7.x86_64 
        python-jsonpatch is needed by cloud-init-0.7.5-6.0.1.el7.x86_64 
        python-prettytable is needed by cloud-init-0.7.5-6.0.1.el7.x86_64
Run the yum install Package name command to install dependency packages, for
example, run the yum install PyYAML command. When message Is this ok [y/d/N]
is displayed, enter y to install a package. When Complete is displayed, the
installation is successful.
Is this ok [y/d/N]: y
 Downloading packages: 
 warning: /var/cache/yum/x86_64/7Server/base/packages/
libyaml-0.1.4-11.el7_0.x86_64.rpm 
 nature, key ID f4a80eb5: NOKEY 
 ... 
 ... 
 Installed: 
   PyYAML.x86_64 0:3.10-11.el7 
 Dependency Installed: 
   libyaml.x86_64 0:0.1.4-11.el7_0 
 Complete!
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Install other dependency packages such as pyserial using the same method.
Run the following command again to install Cloud-Init:
rpm -ivh cloud-init-0.7.9-4.el7.x86_64.rpm

6. Run the following command to check the version number:
cloud-init -v
– For Red Hat 6.5, Red Hat 6.7, Red Hat 6.8, Red Hat 6.9, CentOS 6.8, CentOS 6.9,

Oracle Linux 6.8, Red Hat 7.2, Red Hat 7.4, CentOS 7.2, and CentOS 7.3, the
installation is successful if the command output is cloud-init 0.7.5.

– For Red Hat 7.3, Red Hat 7.4, CentOS 7.2, and CentOS 7.3, the installation is
successful if the command output is cloud-init 0.7.9.

3.5.2 SUSE 11 SP4
1. Add the zypper source configuration file.

a. Run the zypper addrepo url command.
url in this command is an HTTP address, for example, http://
download.opensuse.org/repositories/home:garloff:OTC:cloudinit/SLE_11_SP4/
home:garloff:OTC:cloudinit.repo

b. Run the zypper refresh command.
2. Install Cloud-Init.

NOTE

The dependent software packages vary depending on the Cloud-Init version. This section uses
cloud-init-0.7.6-27.19.1.x86_64.rpm as an example. You can use the latest version.

Step 1: Install cloud-init-0.7.6-27.19.1.x86_64.rpm.

a. Obtain the Cloud-Init installation package.
Visit the SUSE official website https://software.opensuse.org/package/cloud-init,
locate SUSE SLE-11 SP4, and click Show unstable packages.
In the displayed Warning dialog box, click Continue.

b. Click 64 Bit shown in the following figure. The browser will automatically
download the Cloud-Init 0.7.6 software package.
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c. Upload the Cloud-Init 0.7.6 to the VM and run the rpm -ivh cloud-
init-0.7.6-27.19.1.x86_64.rpm command to query the dependent packages.

Step 2: Install the dependent software packages.
Download dependent software packages from the zypper source. If some dependent
software packages are not contained in the zypper source, download them from the
SUSE official website https://software.opensuse.org/search and then upload them to
the VM.

a. Install python-six.
Visit the SUSE official website https://software.opensuse.org/search and search
for python-six.
Click python-six in the search result, locate the SUSE 11 SP4 OS with OTC, and
click 64 Bit.
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Upload the package to the VM and run the rpm -ivh python-six-xxx command to
install python-six. The methods of installing other dependent packages are similar
to this.

b. During the installation, you are not prompted of the python-six dependent package
and need to install it.
Run the rpm -ivh Package name command to upload the package to the VM and
install it.
linux-dann:/tmp # rpm -ivh python-six-1.10.0-5.1.x86_64.rpm
warning: rpm -ivh python-six-1.10.0-5.1.x86_64.rpm: Header V3 DSA signa
Preparing...
   1:python-six

c. Download the following dependent packages from the zypper source (the version
numbers are only for reference and the latest versions are recommended):
python-Cheetah-2.4.4
python-oauth-1.0.1
python-PyYAML-3.11
python-pyserial-3.0.1
growpart-0.29-7.1
Run the zypper install python-cheetah command to install the python-Cheetah
package. The methods of downloading other dependent packages are the same.

d. Download the following dependent packages from the SUSE official website (the
version numbers are only for reference and the latest versions are recommended)
and run the rpm -ivh Package name command to upload them to the VM and
install them:
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python-configobj-4.7.2-1.10.32.x86_64.rpm
python-Jinja2-2.8-69.10.x86_64.rpm
python-jsonpatch-1.11-25.9.x86_64.rpm
python-jsonpointer-1.9-5.2.x86_64.rpm
python-MarkupSafe-0.23-36.14.x86_64.rpm
python-PrettyTable-0.7.2-11.14.x86_64.rpm
python-requests-2.12.4-1.2.x86_64.rpm

Step 3: Install the rpm package of Cloud-Init.
Run the rpm -ivh cloud-init-0.7.6-32.8.x86_64.rpm command to install Cloud-Init.
Step 4: Query the Cloud-Init version.
Run the cloud-init -v command to query the Cloud-Init version to check whether the
installation is successful.

3. Configure the cloud.cfg file that defines the initialization tasks of Cloud-Init.
Modify the /etc/cloud/cloud.cfg configuration file to customize the function
configuration during BMS initialization using Cloud-Init.
The following content is only for reference:

a. Add the key-value pair no_ssh_fingerprints: true and ensure that it has a blank
row before and after it.
no_ssh_fingerprints: true

b. Change the value of users to default.
users:
 - default

c. Modify the following content:
disable_root: True
ssh_pwauth: false
preserve_hostname: false
syslog_fix_perms: root:root

d. Use the number sign (#) to comment out the following rows:
mount_default_fields: [~, ~, 'auto', 'defaults', '0', '2']
manual_cache_clean: true

e. Add the following content:
network:
  config: disabled
growpart:
  mode: false

f. Add the following content after - final-message in cloud_final_modules:
- power-state-change

g. Modify the content under system info as follows:
system_info:
   distro: sles
   default_user:
     name: linux
     lock_passwd: True
     gecos: redhat
     groups: [audio, cdrom, dialout, floppy, video]
     sudo: ["ALL=(ALL) NOPASSWD:ALL"]
     shell: /bin/bash
    paths:
      cloud_dir: /var/lib/cloud/
      templates_dir: /etc/cloud/templates/
    ssh_svcname: sshd
Change the value of distro based on the OS type, such as sles and rhel. In this
section, SUSE 11 SP4 is used as an example. Change the value of distro to sles.
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h. Use the number sign (#) to comment out the following row:
ssh_genkeytypes: ['rsa', 'dsa']

3.5.3 SUSE 12
NOTE

This section describes how to install Cloud-Init for SUSE 12 SP1 and also its differences from installing
Cloud-Init on SUSE 12 SP2 or SUSE 12 SP3.

1. Install Cloud-Init.

a. Run the zypper addrepo url command.
url is a specific HTTP address. The followings are two examples:
n http://download.opensuse.org/repositories/home:/garloff:/OTC:/cloudinit/

SLE_12/home:garloff:OTC:cloudinit.repo
n http://download.opensuse.org/repositories/Cloud:/Tools/SLE_12_SP1/

Cloud:Tools.repo
Table 3-4 lists the zypper source addresses of SUSE 12 SP2 and SUSE 12 SP3. You
need to run the preceding command twice to load the .repo files locally.

Table 3-4 zypper source addresses

OS
Version

zypper Source Address

SUSE 12
SP1

http://download.opensuse.org/repositories/home:/garloff:/OTC:/
cloudinit/SLE_12/home:garloff:OTC:cloudinit.repo
http://download.opensuse.org/repositories/Cloud:/Tools/
SLE_12_SP1/Cloud:Tools.repo
NOTE

Add both the preceding addresses.

SUSE 12
SP2

http:download.opensuse.org/repositories/home:/garloff:/OTC:/
cloudinit/SLE_12/home:garloff:OTC:cloudinit.repo
http://download.opensuse.org/repositories/Cloud:/Tools/
SLE_12_SP2/Cloud:Tools.repo
NOTE

Add both the preceding addresses.

SUSE 12
SP3

http://download.opensuse.org/repositories/home:/garloff:/OTC:/
cloudinit/SLE_12/home:garloff:OTC:cloudinit.repo
http://download.opensuse.org/repositories/Cloud:/Tools/
SLE_12_SP3/Cloud:Tools.repo
NOTE

Add both the preceding addresses.

 
b. Run the zypper refresh command and enter t.

linux-fuvn:/home/fsp # zypper refresh
Retrieving repository 'Cloud:Tools (SLE_12_SP1)' 
metadata .............................................[\]
New repository or package signing key received:
  Repository:      Cloud:Tools (SLE_12_SP1)
  Key Name:        Cloud OBS Project <Cloud@build.opensuse.org>
  Key Fingerprint: 104853F0 8B86F4AE F4488DFE 95140AF6 05F4861F
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  Key Created:     Tue 21 Mar 2017 06:04:52 AM CST
  Key Expires:     Thu 30 May 2019 06:04:52 AM CST
  Rpm Name:        gpg-pubkey-05f4861f-58d05204

Do you want to reject the key, trust temporarily, or trust always? [r/t/
a/? shows all options] (r): t
...

c. Run the zypper install cloud-init command. Enter 2 if you are prompted to choose
a solution.
linux-fuvn:/etc/zypp/repos.d # zypper install cloud-init
Loading repository data...
Reading installed packages...
Resolving package dependencies...
Problem: nothing provides python-requests needed by cloud-
init-17.1-3.2.x86_64
  Solution 1: do not install cloud-init-17.1-3.2.x86_64
  Solution 2: break cloud-init-17.1-3.2.x86_64 by ignoring some of its 
dependencies
Choose from above solutions by number or cancel [1/2/c] (c): 2
...
Continue? [y/n/? shows all options] (y): y

2. Handle errors during installation.
Failed to mount cd:///?devices=/dev/disk/by-id/ata-QEMU_DVD-ROM_QM00003 
on /var/adm/mount/AP_0xgXejgU: Mounting media failed (mount: no medium found 
on /dev/sr0)
If the preceding error occurs, run the zypper sd SLES12-SP1-12.1-0 command to delete
the default ISO file of SUSE 12.1.
– For SUSE 12 SP2, run the zypper sd SLES12-SP2-12.2-0 command to delete the

default ISO file of SUSE 12 SP2.
– For SUSE 12 SP3, run the zypper sd SLES12-SP3-12.3-0 command to delete the

default ISO file of SUSE 12 SP3.
Run the zypper refresh command.

3. Run the zypper install cloud-init command.
4. Run the cloud-init -v command.

NOTE

For SUSE 12 SP3, you can view the version information after running cloud-init -v. You do not
need to perform subsequent operations.

If some packages are not installed, information similar to that shown in the following
will be displayed.
...
File "/usr/lib/python2.7/site-packages/pkg_resources/_init_.py", line 867, in 
resolve
  raise DistributionNotFound(req, requirers)
pkg_resources.DistributionNotFound: The 'requests' distribution was not found 
and is required by...
Run the zypper install python-* command to install the packages that are missing.
* is the package that has not been installed, such as requests shown in the preceding
output.
If you are prompted that this package does not exist, install and configure the pip tool.
Otherwise, skip the next step. If you use the pip tool, run the pip install requests
command. To install dependent packages, use zypper first. If it does not work, use pip.
linux-3jhn:~/.pip # zypper install python-requests
Loading repository data...
Reading installed packages...
Package 'python-requests' not found.
Resolving package dependencies...

Bare Metal Server
Private Image Creation Guide 3 Creating a Linux Image

Issue 01 (2018-05-15) 40



5. (Optional) Install and configure the pip file.

a. Run the zypper install python-pip command to install pip.

b. Run the following commands to configure pip.

n Run the cd ~ command.

n Run the mkdir .pip command.

n Run the cd .pip command.

n Run the vi pip.conf command to create a pip.conf file. The content may be an
image website as follows (you can also configure it based on the PyPI official
website):
[global]
trusted-host= pypi.tuna.tsinghua.edu.cn
index-url=https://pypi.tuna.tsinghua.edu.cn/simple

6. Run the cloud-init -v command to verify the installation. If the version information is
displayed, the installation is successful.

3.5.4 EulerOS 2.2
1. Configure the yum source for EulerOS 2.2 in the /etc/yum.repo.d/EulerOS-base.repo

file:
[EulerOS-base]
name=EulerOS-base
baseurl=http://developer.huawei.com/ict/site-euleros/euleros/repo/yum/2.2/os/
x86_64/
enabled=1
gpgcheck=1
gpgkey=http://developer.huawei.com/ict/site-euleros/euleros/repo/yum/2.2/os/
RPM-GPG-KEY-EulerOS

Edit and save the file.

2. Run the yum repolist command and then yum install cloud-init command to install
Cloud-Init 0.7.6.

Dependent packages of Cloud-Init 0.7.6 will also be installed automatically.
Installed:
  cloud-init.x86_64 0:0.7.6-2

Dependency Installed:
  PyYAML.x86_64 0:3.10-11                                       audit-libs-
python.x86_64 0:2.4.1-5
  checkpolicy.x86_64 0:2.1.12-6                                 libsemanage-
python.x86_64 0:2.1.10-18
  libyaml.x86_64 0:0.1.4-11                                     
policycoreutils-python.x86_64 0:2.2.5-15.h1
  python-IPy.noarch 0:0.75-6                                    python-
backports.x86_64 0:1.0-8
  python-backports-ssl_match_hostname.noarch 0:3.4.0.2-4        python-
jsonpatch.noarch 0:1.2-2
  python-jsonpointer.noarch 0:1.9-2                             python-
prettytable.noarch 0:0.7.2-1
  python-requests.noarch 0:2.6.0-1                              python-
six.noarch 0:1.9.0-2
  python-urllib3.noarch 0:1.10.2-2                              setools-
libs.x86_64 0:3.3.7-46

Complete!

NOTE

If you are prompted that dependent packages are missing, perform the operation in step 5 in
section Red Hat, CentOS, and Oracle Linux.
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3. To inject the password of user root, run the yum install selinux-policy command to
upgrade selinux-policy from h1 to h2.

4. Run the cloud-init -v command. If the command output is cloud-init 0.7.6, the
installation is successful.

3.5.5 Ubuntu 16.04
For the x86 image, perform the first four steps. For the ARM 64 image, run the apt install
cloud-init command and skip the step 1 to step 4.

1. Configure the apt source.
If the VM needs to access the Internet through a proxy, configure the apt proxy.
Otherwise, skip this step.
Run the following commands:
cd /etc/apt/
vim apt.conf
Modify the file and change the proxy IP address and port.
  Acquire::http::Proxy "http://191.200.5.88:3128";
  ~
  ~
  ~

2. Run the apt update command.

If information shown in the preceding figure is displayed, the network connection is
unstable. Run the apt update command again until no exceptions occur.
Run the apt-get install cloud-init command.

3. If the update fails and information shown in the following figure is displayed, manually
download the apt source.

Download cloud-init_17.1-18-gd4f70470-0ubuntu1_all.deb (the version is only for
reference) at https://packages.ubuntu.com/.
Upload the package to the VM, enter the directory where the package is stored, and run
the following command:
dpkg -i cloud-init_17.1-18-gd4f70470-0ubuntu1_all.deb
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The following command output is displayed.

If some dependent packages are unavailable as shown in the preceding figure, download
and install the following required packages as prompted (version numbers and the
number of packages are only for reference):
python3-blinker_1.3.dfsg2-1build1_all.deb
python3-cffi-backend_1.5.2-1ubuntu1_amd64.deb
python3-configobj_5.0.6-2_all.deb
python3-cryptography_1.2.3-1ubuntu0.1_amd64.deb
python3-idna_2.0-3_all.deb
python3-jinja2_2.8-1_all.deb
python3-jsonpatch_1.19-3_all.deb
python3-json-pointer_1.9-3_all.deb
python3-jsonschema_2.5.1-4_all.deb
python3-jwt_1.3.0-1_all.deb
python3-markupsafe_0.23-2build2_amd64.deb
python3-oauthlib_1.0.3-1_all.deb
python3-pyasn1_0.1.9-1_all.deb
python3-serial_3.0.1-1_all.deb
python3-requests_2.9.1-3_all.deb
python3-urllib3_1.13.1-2_all.deb
libyaml-0-2_0.1.6-3_amd64.deb
python3-yaml_3.11-3build1_amd64.deb
After installing the packages, run the apt-get update command to update the apt source.
Then you can download software packages by running the apt-get install command.
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4. Install the python3-six installation package although no prompt is displayed. Download
the following package:
apt-get install python3-six

5. Run the cloud-init -v command. If the output is cloud-init 17.1, the installation is
complete.

6. Install the SSH service.
For the x86 image, run the following commands:
apt-get install openssh-client
apt-get install openssh-server
For the ARM 64 image, run the following commands:
apt install openssh-client
apt install openssh-server

7. Install the dkms tool.
To prevent any SDI driver exceptions, run the apt-get install dkms command to install
the dkms tool online.
After installation, run the vi /usr/sbin/dkms command. Press Shift+: to enter the CLI,
enter 283, and press Enter to go to the 283th row, and change it to the following:
invoke_command "$mkinitrd -f $initrd_dir/$initrd $1" "$mkinitrd" background

3.5.6 Ubuntu 14.04
1. Configure the apt source.

If the VM needs to access the Internet through a proxy, configure the apt proxy.
Otherwise, skip this step.
Run the following commands:
cd /etc/apt/
vim apt.conf
Modify the file and change the proxy IP address and port.
  Acquire::http::Proxy "http://191.200.5.88:3128";
  ~
  ~
  ~

2. Run the apt update command.

If information shown in the preceding figure is displayed, the network connection is
unstable. Run the apt update command again until no exceptions occur.
Run the apt-get install cloud-init command.
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3. Run the cloud-init -v command. If the output is cloud-init 0.7.5, the installation is
complete.

4. Install the SSH service.
Before installing openssh-server, run the following command to delete residual
configuration files from the system:
rm /etc/ssh/sshd_config
Run the following commands to install the SSH service:
apt-get install openssh-client
apt-get install openssh-server

5. Run the following commands to install the vlan and ifenslave services:
apt-get install vlan
apt-get install ifenslave

6. Modify the /etc/network/interfaces configuration file and add the following statement
to the end of the file:
source /etc/network/interfaces.d/*cfg

7. Install the dkms tool.
To prevent any SDI driver exceptions, run the apt-get install dkms command to install
the dkms tool online.
After installation, run the vi /usr/sbin/dkms command. Press Shift+: to enter the CLI,
enter 282, and press Enter to go to the 282th row, and change it to the following:
invoke_command "$mkinitrd -f $initrd_dir/$initrd $1" "$mkinitrd" background

3.6 Configuring Cloud-Init
Configure the cloud.cfg file that defines the initialization tasks of Cloud-Init.

Modify the /etc/cloud/cloud.cfg configuration file to customize the function configuration
during BMS initialization using Cloud-Init. The following content is only for reference.

3.6.1 Configuring Cloud-Init 0.7.5
1. Add the key-value pair no_ssh_fingerprints: true and ensure that it has a blank row

before and after it.
no_ssh_fingerprints: true

2. Set the value of ssh_pwauth to false. This parameter specifies whether SSH password
login is supported. If it is set to false, SSH password login is disabled.
ssh_pwauth: false

3. Add preserve_hostname: false.
preserve_hostname: false

4. Use the number sign (#) to comment out the following fields:
mount_default_fields: [~, ~, 'auto', 'defaults,nofail', '0', '2']
resize_rootfs_tmp: /dev
ssh_deletekeys:   0

5. Change the value of ssh_genkeytypes to ['rsa', 'dsa'].
ssh_genkeytypes: ['rsa', 'dsa']

6. Change the value of syslog_fix_perms to root:root.
syslog_fix_perms: root:root

7. Add the following content:
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network:
   config: disabled
datasource_list: [ OpenStack ]

NOTICE
For Ubuntu 14.04, do not add the following information:
datasource_list: [ OpenStack ]

8. Add the following content after - final-message in cloud_final_modules:
- power-state-change

9. Modify the content under system info as follows:
system_info:
   default_user:
     name: linux   //Username for logging in to the OS
     lock_passwd: True   //True indicates that password login is disabled. In 
some OSs, 1 indicates that password login is disabled.
     gecos: redhat
     groups: [audio, cdrom, dialout, floppy]   //(Optional) This parameter 
specifies the groups to which the user is added. The values must be groups 
that exist in the etc/group of the OS.
     sudo: ["ALL=(ALL) NOPASSWD:ALL"]   //The user has all permissions of 
user root.
     shell: /bin/bash   //The bash command is used to execute the shell 
script.
   distro: sles
    paths:
      cloud_dir: /var/lib/cloud/
      templates_dir: /etc/cloud/templates/
      upstart_dir: /etc/init/
    ssh_svcname: sshd
The value of distro varies depending on the OS and can be sles, rhel, ubuntu, debian,
or fedora.

10. (Optional) For Ubuntu 14.04, perform the following operations:

a. Use the vi editor to open the /etc/init/cloud-init-local.conf configuration file and
modify the following configuration items:
# cloud-init - the initial cloud-init job
#   crawls metadata service, emits cloud-config
start on mounted MOUNTPOINT=/ and mounted MOUNTPOINT=/run and stopped 
bms-network_config

b. Run the following command to configure the OpenStack source:
dpkg-reconf igure cloud-init
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Run the vim /etc/cloud/cloud.cfg.d/90_dpkg.cfg command to open the
configuration file and check the configuration items.
# to update this file, run dpkg-reconf igure cloud-init
datasource_list: [ OpenStack ]
~
~
~
If the preceding information is displayed, the configuration is successful.

3.6.2 Configuring Cloud-Init 0.7.6
1. Add the key-value pair no_ssh_fingerprints: true and ensure that it has a blank row

before and after it.
no_ssh_fingerprints: true

2. Change the value of users to default.
users:
     - default

3. Modify the following content:
disable_root: True
preserve_hostname: false
syslog_fix_perms: root:root

4. Add parameter ssh_pwauth. This parameter specifies whether SSH password login is
enabled. If it is set to false, SSH password login is disabled.
ssh_pwauth: false

5. Use the number sign (#) to comment out the following rows:
mount_default_fields: [~, ~, 'auto', 'defaults', '0', '2']
manual_cache_clean: true

6. Add the following content:
network:
  config: disabled
datasource_list: [ OpenStack ]
For SUSE 11 SP4, add the following information:
growpart:
  mode: false

7. Modify the content under system info as follows:
– EulerOS 2.2 configuration:

system_info:
   distro: sles
   default_user:
     name: linux   //Username for logging in to the OS
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     lock_passwd: True   //True indicates that password login is 
disabled. In some OSs, 1 indicates that password login is disabled.
     gecos: redhat
     groups: [audio, cdrom, dialout, dip, floppy, video]   //(Optional) 
This parameter specifies the groups to which the user is added. The 
values must be groups that exist in the etc/group of the OS.
     sudo: ["ALL=(ALL) NOPASSWD:ALL"]   //The user has all permissions 
of user root.
     shell: /bin/bash   //The bash command is used to execute the shell 
script.
    paths:
      cloud_dir: /var/lib/cloud/
      templates_dir: /etc/cloud/templates/
    ssh_svcname: sshd

– SUSE 11 SP4 configuration:
system_info:
   distro: sles
   default_user:
     name: linux
     lock_passwd: True
     gecos: redhat
     groups: [audio, cdrom, dialout, floppy, video]
     sudo: ["ALL=(ALL) NOPASSWD:ALL"]
     shell: /bin/bash
    paths:
      cloud_dir: /var/lib/cloud/
      templates_dir: /etc/cloud/templates/
    ssh_svcname: sshd

The value of distro varies depending on the OS and can be sles, rhel, ubuntu, debian,
or fedora.

8. Use the number sign (#) to comment out the following row:
ssh_genkeytypes: ['rsa', 'dsa']

9. (Optional) For EulerOS 2.2, perform the following operation:

In the /etc/pam.d/su configuration file, check whether the line shown in the red box in
the following figure has been commented out using the number sign (#). If yes, skip this
step.

3.6.3 Configuring Cloud-Init 0.7.9
1. Add the key-value pair no_ssh_fingerprints: true and ensure that it has a blank row

before and after it.
no_ssh_fingerprints: true

2. Set the value of ssh_pwauth to false.
ssh_pwauth: false

3. Add preserve_hostname: false.
preserve_hostname: false
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4. Use the number sign (#) to comment out the following fields:
mount_default_fields: [~, ~, 'auto', 'defaults,nofail', '0', '2']
resize_rootfs_tmp: /dev
ssh_deletekeys:   0
ssh_genkeytypes: ~
syslog_fix_perms: ~

5. Change the value of ssh_genkeytypes to ['rsa', 'dsa'].
ssh_genkeytypes: ['rsa', 'dsa']

6. Change the value of syslog_fix_perms to root:root.
syslog_fix_perms: root:root

7. Add the following content:
network:
   config: disabled
datasource_list: [ OpenStack ]

8. Add the following content after - final-message in cloud_final_modules:
- power-state-change

9. Modify the content under system info as follows:
system_info:
   default_user:
     name: linux   //Username for logging in to the OS
     lock_passwd: True   //True indicates that password login is disabled. In 
some OSs, 1 indicates that password login is disabled.
     gecos: redhat
     groups: [adm, audio, cdrom, dialout, dip, floppy, lxd, netdev, plugdev, 
sudo, video]   //(Optional) This parameter specifies the groups to which the 
user is added. The values must be groups that exist in the etc/group of the 
OS.
     sudo: ["ALL=(ALL) NOPASSWD:ALL"]   //The user has all permissions of 
user root.
     shell: /bin/bash   //The bash command is used to execute the shell 
script.
   distro: rhel
    paths:
      cloud_dir: /var/lib/cloud/
      templates_dir: /etc/cloud/templates/
      upstart_dir: /etc/init/
    ssh_svcname: sshd

The value of distro varies depending on the OS and can be sles, rhel, ubuntu, debian,
or fedora.

3.6.4 Configuring Cloud-Init 17.1 and Cloud-Init 17.2
1. Add the key-value pair no_ssh_fingerprints: true and ensure that it has a blank row

before and after it.
no_ssh_fingerprints: true

2. Change the value of users to default.
users: 
     - default

3. Change the value of disable_root to true. This parameter specifies whether remote login
over SSH as user root is enabled.
disable_root: true

4. Add the value of ssh_pwauth to false or 0. This parameter specifies whether remote
login over SSH as user root is enabled.
ssh_pwauth: false

5. Add the following content:
network:
    config: disabled
datasource_list: [ OpenStack ]
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NOTICE
For Ubuntu 16.04, do not add the following information:
datasource_list: [ OpenStack ]

6. Add the following content after - final-message in cloud_final_modules:
- power-state-change

7. Modify the content under system info as follows:
system_info:
   distro: sles
   default_user:
     name: linux   //Username for logging in to the OS
     lock_passwd: True   //True indicates that password login is disabled. In 
some OSs, 1 indicates that password login is disabled.
     gecos: redhat
     groups: [adm, audio, cdrom, dialout, dip, floppy, lxd, netdev, plugdev, 
sudo, video]   //(Optional) This parameter specifies the groups to which the 
user is added. The values must be groups that exist in the etc/group of the 
OS.
     sudo: ["ALL=(ALL) NOPASSWD:ALL"]   //The user has all permissions of 
user root.
     shell: /bin/bash   //The bash command is used to execute the shell 
script.
    paths:
      cloud_dir: /var/lib/cloud/
      templates_dir: /etc/cloud/templates/
    ssh_svcname: sshd
The value of distro varies depending on the OS and can be sles, rhel, ubuntu, debian,
or fedora.

8. (Optional) For SUSE 12 SP1, SUSE 12 SP2, and SUSE 12 SP3, run the following
command to modify configuration item [Unit] in the /usr/lib/systemd/system/cloud-
init-local.service configuration file:
vi /usr/lib/systemd/system/cloud-init-local.service
Ensure that the value of [Unit] is the same as the following:
[Unit]
Description=Initial cloud-init job (pre-networking)
DefaultDependencies=no
Wants=network-pre.target
Wants=local-fs.target
After=local-fs.target
Before=network-pre.target
Before=shutdown.target
Before=basic.target
Conflicts=shutdown.target
# Other distros use Before=sysinit.target. There is not a clearly identified
# reason for usage of basic.target instead.

9. (Optional) For Ubuntu 16.04, run the following command to configure the OpenStack
source:
dpkg-reconf igure cloud-init

3.7 Checking the Cloud-Init Status
Check whether Cloud-Init automatically starts after bms-network-config is installed.

Bare Metal Server
Private Image Creation Guide 3 Creating a Linux Image

Issue 01 (2018-05-15) 50



3.7.1 SUSE 11 SP4
1. Run the yast command and select System using up and down arrow keys.
2. Press Tab and then select System Services (Runlevel).
3. Press Enter.

The following figure is displayed, and the four services of Cloud-Init are all enabled. If a
service does not start, configure it, as shown in the following figure.

3.7.2 SUSE 12 SP1
1. Check whether the automatic start of Cloud-Init has been configured successfully:

To query the Cloud-Init status, run the yast command and use up and down arrow keys
to select System. Then press Tab and use up and down arrow keys to select System
Manager.
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2. As shown in the preceding figure, the four services of Cloud-Init have started. Active
indicates that the service has been enabled. If a service does not start, select it using up
and down arrow keys, press Tab, and click Enable/Disable to configure it.

3.7.3 SUSE 12 SP2, SUSE 12 SP3, Oracle Linux 7, Red Hat 7,
CentOS 7, and CentOS 7.4 for ARM

1. Run the following commands to check whether the automatic start of Cloud-Init has
been configured successfully:
service cloud-init-local status
service cloud-init status
service cloud-config status
service cloud-final status

2. If the command output contains enabled, the automatic start has been configured.
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If Cloud-Init does not start, run the following commands to configure it:
systemctl enable cloud-init-local
systemctl enable cloud-init
systemctl enable cloud-config
systemctl enable cloud-final

3.7.4 EulerOS 2.2
1. Run the following commands to check whether the automatic start of Cloud-Init has

been configured successfully:
service cloud-init-local status
service cloud-init status
service cloud-config status
service cloud-final status

2. If command output contains enabled, Cloud-Init has been configured successfully.

If Cloud-Init does not start, run the following commands to configure it:
systemctl enable cloud-init-local
systemctl enable cloud-init
systemctl enable cloud-config
systemctl enable cloud-final

3.7.5 Red Hat 6, CentOS 6, and Oracle Linux 6
1. Run the following command:

chkconfig --list | grep cloud
If on is displayed in the red boxes in the following figure, the services have started.

2. If four services of Cloud Init have not started, run the following commands:
chkconfig cloud-init on
chkconfig cloud-init-local on
chkconfig cloud-config on
chkconfig cloud-final on
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3.7.6 Ubuntu 16.04
1. Run the following commands:

systemctl status cloud-init
systemctl status cloud-init-local
systemctl status cloud-config
systemctl status cloud-final
If enabled is displayed in the red boxes in the following figure, services have started.

2. If four services of Cloud-Init have not started, run the following commands:
systemctl enable cloud-init
systemctl enable cloud-init-local
systemctl enable cloud-config
systemctl enable cloud-final

3.7.7 Ubuntu 14.04
Run the following commands:

initctl status cloud-init

initctl status cloud-init-local

initctl status cloud-config

initctl status cloud-final

If the Cloud-Init component installation information similar to that shown in the following is
displayed, the installation is successful.

[root@ubuntu:~]# initctl status cloud-init
cloud-init stop/waiting
[root@ubuntu:~]# initctl status cloud-init-local
cloud-init-local stop/waiting
[root@ubuntu:~]# initctl status cloud-config
cloud-config stop/waiting
[root@ubuntu:~]# initctl status cloud-final
cloud-final stop/waiting
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3.8 Modifying the Hardware Device Driver That Boots the
OS

Scenarios

This section describes how to modify the hardware device driver that is loaded during OS
startup.

Prerequisites

You have logged in to the VM.

Procedure
1. Add or modify the configuration file.

– For Red Hat, Oracle Linux, EulerOS 2.2, SUSE 12 SP1, SUSE 12 SP2, SUSE 12
SP3, and CentOS, use the vi editor to open the /etc/dracut.conf file and change or
add the value of add_drivers.
As shown in the following, the value of add_drivers is the driver of the server's
RAID controller card.
logfile=/var/log/dracut.log
# fileloglvl=7
...
...
# additional kernel modules to the default
add_drivers+="ahci megaraid_sas mpt3sas mpt2sas"

– For Ubuntu 14.04, use the vi editor to open the /etc/initramfs-tools/modules file
and add ahci, megaraid_sas, mpt3sas, and mpt2sas drivers (the format depends on
the OS).
# List of modules that you want to include in your initramfs.
# They will be loaded at boot time in the order below.
#
# Syntax:  module_name [args ...]
#
# You must run update-initramfs(8) to effect this change.
#
# Examples:
#
# raid1
# sd_mod
ahci
megaraid_sas
mpt3sas
mpt2sas

– For Ubuntu 16.04, add the drivers to both the /etc/dracut.conf and /etc/initramfs-
tools/modules files. Before editing the files, install required software.

i. Run the following command to install dracut:
apt-get install dracut
After the installation is complete, add add_drivers+="ahci megaraid_sas
mpt3sas mpt2sas" to the end of the /etc/dracut.conf file by performing
operations similar to those for Red Hat and Oracle Linux 7.3.

ii. Run the following command to install initramfs-tools:

Bare Metal Server
Private Image Creation Guide 3 Creating a Linux Image

Issue 01 (2018-05-15) 55



apt-get install initramfs-tools
After the installation is complete, add the ahci, megaraid_sas, mpt3sas, and
mpt2sas drivers to the end of the /etc/initramfs-tools/modules file by
performing operations similar to those for Ubuntu 14.04.

– For Ubuntu 16.04 for ARM, run the following commands to update the kernel and
driver, and then restart the VM:
sudo apt-get update
sudo apt-get dist-upgrade

– For SUSE 11 SP4, use the vi editor to open the/etc/sysconfig/kernel file and
change the value of INITRD_MODULES.
As shown in the following, the value of INITRD_MODULES= is the driver of the
server's RAID controller card.
...
#
INITRD_MODULES="ahci megaraid_sas mpt3sas mpt2sas"
## Type:   string(yes)
...

NOTE

You can enter multiple RAID controller card drivers separated by spaces. The RAID controller
card driver name can be obtained from the purchased hardware device. Images support coexistence
of multiple RAID controller card drivers, for example, mpt2sas, megaraid_sas, and mpt3sas. If the
OS does not support a hardware driver, it must be installed.

2. Update the kernel. For Ubuntu 16.04 for ARM, skip this step.
For Rad Hat, Oracle Linux, EulerOS 2.2, SUSE 12 SP1, SUSE 12 SP2, SUSE 12 SP3,
Ubuntu 16.04, and CentOS, run the dracut -f command.
– For Rad Hat, Oracle Linux, EulerOS 2.2, and CentOS, run the dracut -f command.

Wait for several seconds, if no command output is returned, the drivers have been
loaded.

– For SUSE 12 SP1, run the dracut -f command and then observe the last few lines
of the command output.
In the command output, the following information is displayed:
...
Some kernel modules could not be included
This is not necessarily an error:
pcmcia
sdhci_acpi
swap
The drivers that are not loaded do not include the manually-added one, indicating
that the RAID card driver has been loaded.

– For SUSE 12 SP2 and SUSE 12 SP3, run the dracut -f command. The kernel is
updated successfully if information similar to the following is displayed.
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– For Ubuntu 14.04 or Ubuntu 16.04, run the following command to generate initrd:

update-initramfs -u
Run the following commands to check whether the ahci, megaraid_sas, mpt3sas,
and mpt2sas drivers have been installed:

lsinitramfs /boot/initrd.img-`uname -r` |grep ahci
lsinitramfs /boot/initrd.img-`uname -r` |grep megaraid_sas
lsinitramfs /boot/initrd.img-`uname -r` |grep mpt3sas
lsinitramfs /boot/initrd.img-`uname -r` |grep mpt2sas

– For SUSE 11 SP4, run the mkinitrd command and check whether the values of
Kernel Modules include the manually added driver.

3. Change the virtual disks in the VM file to physical disks. For Red Hat 7.3, Oracle Linux
7.3, SUSE 12 SP1, and EulerOS 2.2, skip this step. For SUSE 11 SP4, perform the
following steps:

NOTE

If the LVM partitioning mechanism is used, perform steps 3.a to 3.e to change the drive letter
mode.
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a. In the /boot/grub directory, run the blkid command to check whether the disk
partitions are normal.
linux-a5d6:/boot/grub # blkid
/dev/sda1: UUID="c23d47f8-ef1b-4c4e-9a3b-5ae138ef7184" TYPE="swap"
/dev/sda2: UUID="27644978-e244-4a8c-996a-03119fdaff71" TYPE="ext3"

If some disk partitions do not have UUIDs, check whether the steps to install the
VM OS are correct and reinstall the VM OS.

b. Use the vi editor to open the /boot/grub/menu.lst file, modify the OS boot
parameters, and save the configuration. The following figures show the original and
modified /boot/grub/memu.lst files.

Original menu.lst file:

Modified menu.lst file:

c. Use the vi editor to open the /boot/grub/device.map file. The following
information shows the original and modified /boot/grub/device.map file.

Original device.map file:
(hd0)   /dev/disk/by-id/ata-QEMU_HARDDISK_QM00001
~

Modified device.map file:
(hd0)   /dev/sda

d. Use the vi editor to open the /etc/fstab file. The following figures show the original
and modified /etc/fstab file.
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Original fstab file:

Modified fstab file:

e. Use the vi editor to open the /etc/mtab file, delete the row that contains the
CDROM of /dev/sr0, and save the configuration. The following figure shows the
modified /etc/mtab file
Modified /etc/mtab file:

NOTE

If no /dev/sr0 configuration item exists, skip this step.

f. Use the vi editor to open the /etc/sysconfig/bootloader file. The following figures
show the original and modified /etc/sysconfig/bootloader file.
Original bootloader file:

Modified bootloader file:
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If SUSE 11 SP4 uses the LVM partitioning mechanism, perform the following operations
to replace the virtual disks in the VM file with the actual physical disks:

a. In the /boot/grub directory, run the blkid command to check whether the disk
partitions are normal.

If some disk partitions do not have UUIDs, check whether the steps to install the
VM OS are correct and reinstall the VM OS.

b. Use the vi editor to open the /boot/grub/menu.lst file, modify the OS boot
parameters, and save the configuration. The following figures show the original and
modified /boot/grub/memu.lst files.
Original menu.lst file:

Modified menu.lst file:

c. Use the vi editor to open the /boot/grub/device.map file. The following
information shows the original and modified /boot/grub/device.map file.
Original device.map file:
(hd0)    /dev/disk/by-id/ata-QEMU_HARDDISK_QM00001
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Modified device.map file:
(hd0)    /dev/sda
~

d. Use the vi editor to open the /etc/fstab file. The following figures show the original
and modified /etc/fstab file.
Original fstab file:

Modified fstab file:

e. Use the vi editor to open the /etc/sysconfig/bootloader file. The following figures
show the original and modified /etc/sysconfig/bootloader file.
Original bootloader file:

Modified bootloader file:

After the configuration is complete, run the mkinitrd command. If the value of resume
is not by-uuid, run the reboot and then mkinitrd command to ensure that the value of
resume is by-uuid.

4. For Ubuntu 16.04 for ARM, modify the grub, fstab, and interfaces files.

a. Modify the parameters in the /etc/default/grub file shown in the following figure.
Change the value of GRUB_DISABLE_LINUX_UUID to true. Then run the
sudo update-grub2 command.
...
# Uncomment if you don't want GRUB to pass "root=UUID=xxx" parameter to 
linux
GRUB_DISABLE_LINUX_UUID=true

# Uncomment to disable generation of recovery mode menu entries
...

b. Change the UUID in the /etc/fstab file to that of /dev/sdax, which can be obtained
by running the sudo blkid command.
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c. Modify the /etc/network/interfaces file and delete all interface information except
the lo interface. The following figure shows the modified information.
# This file describes the network interfaces available on your system
# and how to activate them. For more information, see interfaces (5).

source /etc/network/interfaces.d/*

# The loopback network interface
auto lo
iface to inet loopback

~
~

3.9 Installing the bms-network-config Software Package

Scenarios

Install the network-config software package that is used together with Cloud-Init to configure
the BMS network.

Prerequisites
l You have logged in to the VM.
l Cloud-Init has been installed.
l The bms-network-config software package (you can download the rpm packages of the

required OSs, and the rpm package of Ubuntu is the deb package) has been uploaded to
the VM.

Procedure
1. Enter the directory where the bms-network-config installation package is stored and run

the following command:
rpm -ivh bms-network-config-1.0-7.centosRedhat7.x86_64.rpm
[root@localhost r74]# rpm -ivh bms-network-
config-1.0-7.centosRedhat7.x86_64.rpm
Preparing...                          ############################### 
[100%]            
Updating / installing...
   1:bms-network-config-1.0.7.centosRe############################### [100%]
Run the dpkg -i xxx command to install Ubuntu (xxx indicates the name of the deb
package).
root@ubuntu:~/file# dpkg -i bms-network-config-1.0.7.ubuntu1604-918.deb
Selecting previously unselected package bms-network-config.
(Reading database ... 97630 files and directories currently installed.)
Preparing to unpack bms-network-config-1.0.7.ubuntu1604-918.deb ...
Unpacking bms-network-config (1.0) ...
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Setting up bms-network-config (1.0) ...
root@ubuntu:~/file# dpkg -s bms-network-config

NOTE

Use the name of the rpm package at your site.

2. After the installation is complete, run the rpm -qa | grep bms-network-config
command. The installation is successful if information similar that shown in the
following figure is displayed.
[root@localhost r74]# rpm -qa | grep bms
bms-network-config-1.0.7.centosRedhat7.x86_64
For Ubuntu, run the dpkg -s bms-network-config command to query the installation
process.

3. Query the status of the bms-network-config service.
– For Oracle Linux 7, Red Hat 7, CentOS 7, Ubuntu 16.04, SUSE 12 SP1, SUSE 12

SP2, SUSE 12 SP3, and EulerOS 2.2, run the service bms-network-config status
command to query the status of the service. If the service is not at enabled status,
run the systemctl enable bms-network-config command to enable the service.
[root@localhost r74]# service bms-network-config status
Redirecting to /bin/systemctl status bms-network-config.service
  bms-network-config.service - Network Config
  Loaded: loaded (/usr/lib/systemd/system/bms-network-config service; 
enabled vendor preset: disabled)
  Active: inactive (dead)

– For Red Hat 6, CentOS 6, SUSE 11 SP4, Oracle Linux 6.8 and Oracle Linux 6.9,
run the chkconfig --list | grep bms-network-config command to query the status
of the service. If the service is not at on status, run the chkconfig bms-network-
config on command to enable the service.
[root@localhost r69]# chkconfig --list | grep bms
bms-network-config   0:off   1:off   2:on   3:on   4:off   5:on   6:off

– For Ubuntu 14.04, run the initctl status bms-network_config command to query
the status of the service.
root@ubuntu:~# initctl status bms-network_config
bms-network_config stop/waiting

3.10 Installing the SDI Card Driver (ARM 64 Server Not
Supported)

To use FusionStorage Block, you must install the SDI card driver on the BMS OS.

If you do not need FusionStorage Block or the BMS does not have an SDI card, you can skip
this section. ARM 64 servers do not support this function, and the SDI card driver is not
required.

Prerequisites
l You have logged in to the VM.
l The SDI card driver (scsi_ep_front) has been uploaded to the VM.

NOTE

The scsi_ep_front must be version 1.0.6 or later.
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Procedure

The following steps are only for reference. The command output for installing the SDI card
driver for images of different versions may vary.

1. Enter the directory where the SDI driver installation package is stored and run the
following command:
rpm -ivh kmod-scsi_ep_front-redhat_7.4_1.0.6-3.10.0_693.el7.redhat.x86_64.rpm

NOTE

The Ubuntu SDI driver uses the deb installation package. Run the dpkg -i xxx (xxx indicates the
name of the SDI installation package) command to install the SDI driver.

2. After the installation is complete, run the rpm -qa | grep scsi command. The installation
is successful if information similar to the following is displayed:
[root@localhost ~] rpm -qa | grep scsi
lsscsi-0.27-6.el7.x86_64
kmod-scsi_ep_front-redhat_7.4_1.0.6-3.10.0_693.el7.redhat.x86_64
For Ubuntu 16.04 and Ubuntu 14.04, run the dkms status command.
...
root@ubuntu:~/file# dkms status
scsi_ep_front, 1.0.6, 4.4.0-21-generic, x86_64: installed
scsi_ep_front, 1.0.6, 4.4.0-59-generic, x86_64: built
scsi_ep_front, 1.0.6, 4.4.0-96-generic, x86_64: installed

3. Run the following commands to check whether the SDI card driver matches the kernel
version:

a. Run the uname -r command to obtain the OS kernel version:
[root@localhost r74]# uname -r
3.10.0-693.el7.x86_64
The kernel version is 3.10.0-693.el7.x86_64.

b. Run the find / -name "*front*.ko" command to check the SDI card driver
matching the kernel version.
[root@localhost r74]# find / -name "*front*.ko"
/usr/lib/modules/3.10.0-693.el7.x86_64/extra/scsi_ep_front/
scsi_ep_front.ko

3.11 Installing the Driver

Preparations
1. Download the .zip package of the driver.

Log in at http://support.huawei.com/enterprise/en/index.html and choose Support >
Servers > Rack Servers > 2288H V5 > Software Download > 2288H V5
V100R005C00SPC112. Download the required driver package based on the image OS.
– CentOS: FusionServer iDriver-CentOS-Driver-V327.zip
– Red Hat Enterprise Linux: FusionServer iDriver-Rhel-Driver-V329.zip
– Windows: FusionServer iDriver-Windows-Driver-V330.zip
Take CentOS 7.3 as an example. Download FusionServer iDriver-CentOS-Driver-
V327.zip.

2. Obtain onboard_driver_centos7.3 iso from the downloaded package.
After decompressing the downloaded package, enter the CentOS-Driver-V327 folder
and then the centos7.3 folder, and obtain the onboard_driver_centos7.3 iso file.
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The onboard_driver_centos7.3 iso is used to install drivers for the V5 server and RAID
card.

3.11.1 (Optional) Installing the IB NIC Driver

Scenarios
This section describes how to install the IB NIC driver on a created VM. CentOS 7.4 is used
as an example. ARM 64 servers do not support this function.

NOTE

1. List of supported OS: CentOS 7.3, CentOS 7.4, RedHat 7.3, RedHat 7.4, and SUSE 12 SP3.
2. IB driver version: If version 4.2 is available at the official website, you are advised to install version

4.2. If version 4.2 is unavailable, you are advised to install version 4.3.

Prerequisites
l You have logged in to the VM.
l The IB NIC driver installation package of the specified OS has been uploaded to the

VM.

Procedure
1. Download OFED.

a. Visit http://www.mellanox.com/ and choose Products > Software >
InfiniBand/VPI Drivers.
The Adapter IB/VPI SW page is displayed.

b. In the navigation pane on the left, choose Mellanox Inbox Drivers to enter the
Adapter Ethernet SW page.

c. In the navigation pane on the left, choose Linux Drivers. On the Download page,
download the .tgz installation package that matches the VM OS and verify its
integrity.
For example, select the package shown in the red box in the following figure for
CentOS 7.4.
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2. Upload the downloaded OFED installation package to the VM. For details, see step 8 in
section Configuring the VM Environment.

3. Run the tar -zxvf xxx (name of the OFED installation package) command to decompress
the OFED installation package.

4. Go to the MLNX_OFED_LINUX-4.2-1.2.0.0-RHEL7.4-X86_64 folder and run the
following command to install OFED:

./mlnxofedinstall
[root@localhost MLNX_OFED_LINUX-4.2-1.2.0.0-rhel7.4-x86_64]# ./mlnxofedinstall
Logs dir: /tmp/MLNX_OFED_LINUX.1479.logs
General log file: /tmp/MLNX_OFED_LINUX.1479.logs/general.log
Verifying KMP rpms compatibility with target kernel...
Error: One or more required packages for installing MLNX_OFED_LINUX are 
missing.
Please install the missing packages using your Linux distribution Package 
Management tool.
Run:
yum install tcl tk

5. Run the yum install xxx (name of the dependency package) command to install required
dependency packages.

For example, run the yum install tcl tk command as prompted.

6. Run the ./mlnxofedinstall command.

The installation is successful if information similar to the following is displayed:
Installation finished successfully.

Preparing...                                    
############################### [100%]
Updating / installing...
   1:mlnx-fw-updater-4.2-1.2.0.0                
############################### [100%]

Added 'RUN_FW_UPDATER_ONBOOT=no to /etc/infiniband/openib.conf
...

7. Run the /etc/init.d/openibd restart command to load the driver.
[root@localhost MLNX_OFED_LINUX-4.2-1.2.0.0-rhel7.4-x86_64]# /etc/init.d/
openibd restart
Uploading HCA driver:                                      [ OK ]
Loading HCA driver and Access Layer:                       [ OK ]

3.11.2 (Optional) Installing the V5 Server Driver

Scenarios

This section describes how to install the X722 NIC driver so that BMSs can be provisioned on
V5 servers. Skip this section for other types of servers.

NOTE

BMSs using the following OSs can be provisioned on V5 servers: CentOS 6.9, Red Hat 6.9, CentOS 7.3,
SUSE 11 SP4, SUSE 12 SP3, and Ubuntu 16.04.

This section uses CentOS 7.3 as an example to describe how to install the V5 server driver.

Procedure
1. Extract the X710_XL710_X722_centos7.3_x86_64_2.2.4.rpm package of the V5 server

from onboard_driver_centos7.3 iso in section Preparations.
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2. Upload the .rpm package to the VM. For details, see step 8 in section Configuring the
VM Environment.

3. Enter the directory where the .rpm package is stored and run the following command to
install the driver:
rpm -ivh X710_XL710_X722_centos7.3_x86_64_2.2.4.rpm
[root@localhost bzqd]# rpm -ivh X710_XL710_X722_centos7.3_x86_64_2.2.4.rpm
Preparing...                            ################################## 
[100%]
Updating / installing...
   1:i40e-2.2.4-1                       ################################## 
[100%]
original pci.ids saved in /usr/local/share/i40e
Updating initrd...
Using dracut to update initrd...
Successfully updated initrd.
[root@localhost bzqd]#

4. After the installation is complete, run the rpm -qa | grep i40e command. The installation
is successful if information similar to the following is displayed:
i40e-2.2.4-1.x86_64

3.11.3 (Optional) Installing the RAID Card Driver

Scenarios
If the server (such as the V5 server) uses the 3408 or 3508 RAID card, you need to install the
RAID card driver for the image.

Procedure
1. Extract the .rpm package from the onboard_driver_centos7.3 iso file in section

Preparations.
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2. Upload the .rpm package to the VM. For details, see step 8 in section Configuring the
VM Environment.

3. Install the RAID card driver.

a. Enter the directory where the .rpm package is stored and run the following
command to install the driver:
rpm -ivh 3508_centos7.3_x86_64_07.703.05.00.rpm
[root@localhost 3508]# rpm -ivh 3508_centos7.3_x86_64_07.703.05.00.rpm
Preparing...                       
###################################### [100%]
         package kmod-megaraid_sas-07.701.17.00_el7.3-1.x86_64 is 
already installed

b. Run the dracut -f command to update the kernel.
4. After the installation is complete, run the rpm -qa | grep raid command to check

whether the installation is successful.
[root@localhost 3508]# rpm -qa | grep raid
dmraid-1.0.0.rc16-28.el7.x86_64
dmraid-events-1.0.0.rc16-28.el7.x86_64
kmod-megaraid_sas-07.701.17.00_el7.3-1.x86_64
[root@localhost 3508]#

3.12 (Optional) Installing the UltraPath
1. Install the UltraPath software by following the instructions in OceanStor UltraPath for

Linux xxx User Guide.

NOTE

l See the document matching the software version.
l To obtain the document, log in at http://support.huawei.com/enterprise/en/index.html and

choose Support > Product Support > Carrier IT > Storage > Enterprise Storage >
UltraPath.
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2. After the installation is complete, run the reboot command to make the UltraPath
software take effect.

3. Run the following command to check whether the UltraPath software version is correct:
upadmin show version

3.13 (Optional) Installing One-Click Password Reset
Plugins

To ensure one-click password reset for Bare Metal Servers created using an image, we
recommend that you install the password reset plug-in Cloud-reset-pwd Agent.

NOTE

To uninstall the plugin, see Uninstall the Password Reset Plugin from a Linux VM.

Notes

You can decide whether to install Cloud-reset-pwd Agent.

Prerequisites

A Linux VM must have larger than 600 MB remaining space and data can be written to its
root directory.

Install the Password Reset Plugin on a Linux VM

Step 1 Check whether CloudResetPwdAgent and CloudResetPwdUpdateAgent have been installed
on the VM.

1. Log in to the VM.
2. Check whether CloudrResetPwdAgent has been installed. To check this, perform the

following operations:

a. Check whether the CloudrResetPwdAgent directory exists in the root directory of
the VM.

b. Run the following command to check whether the status of CloudResetPwdAgent is
unrecognized service:
service cloudResetPwdAgent status

If the CloudResetPwdAgent directory exists in the root directory of the VM and the
status of CloudResetPwdAgent is not unrecognized service, CloudResetPwdAgent has
been installed on the VM.
– If yes, go to Step 1.3.
– If no, go to Step 2.

3. Check whether CloudResetPwdUpdateAgent has been installed. To check this, perform
the following operations:

a. Check whether the CloudResetPwdUpdateAgent directory exists in the root
directory of the VM.

b. Run the following command to check whether the status of
CloudResetPwdUpdateAgent is unrecognized service:

Bare Metal Server
Private Image Creation Guide 3 Creating a Linux Image

Issue 01 (2018-05-15) 69



service cloudResetPwdUpdateAgent status

If both of the preceding conditions are met, CloudResetPwdUpdateAgent has been
installed on the VM.
– If yes, no further action is required.
– If no, go to Step 2.

Step 2 Download password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

NOTE

CloudResetPwdAgent can be automatically upgraded only if an EIP is bound to the BMS. You can also
download the upgrade package and upgrade CloudResetPwdAgent manually.

Download and decompress CloudResetPwdAgent.zip.

Download path: http://bms-image-package.obs.myhwclouds.com/linux/reset_pwd_agent/
CloudResetPwdAgent.zip

Step 3 Install password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

1. Place the files extracted in Step 2 in the same directory of the VM (otherwise, the
installation will fail).

NOTE

There is no special requirement for the directory. You only need to ensure that the extracted files
are in the same directory.

2. Run the following command to open the CloudResetPwdUpdateAgent.Linux file:
cd CloudResetPwdUpdateAgent.Linux

3. Run the following command to add the execute permission for the setup.sh file:
chmod +x setup.sh

4. Run the following command to install the plugins:
sudo sh setup.sh

5. Run the following commands to check whether the installation is successful:
service cloudResetPwdAgent status
service cloudResetPwdUpdateAgent status
If the status of CloudResetPwdAgent and CoudResetPwdUpdateAgent is not
unrecognized service, the installation is successful. Otherwise, the installation fails.

NOTE

If the installation fails, check whether the installation environment meets requirements and install
the plugin again.

----End

Uninstall the Password Reset Plugin from a Linux VM

Log in to the VM and run the following commands:

1. sudo bash /CloudrResetPwdAgent/bin/cloudResetPwdAgent.script remove
2. sudo bash /CloudResetPwdUpdateAgent/bin/cloudResetPwdUpdateAgent.script

remove
3. sudo rm -rf /CloudrResetPwdAgent
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4. sudo rm -rf /CloudResetPwdUpdateAgent

3.14 Performing Security Configurations

Modifying SSH Configuration Items

You can configure permissions of users for logging in to a BMS based on the user type. Select
the type of the account for logging in to the BMS.

1. To improve security of the BMS, disable remote login using the password and retain
only the certificate login mode. Check whether the value of parameter
ChallengeResponseAuthentication in the /etc/ssh/sshd_config file is no. If not, change
it to no so that users cannot log in to a BMS through Xshell by entering the password
using the keyboard inactive method.

2. To allow user root to log in remotely and enable SSH permissions of user root, perform
the following operations:

NOTICE
Allowing user root to log in to the BMS remotely has potential security risks. Exercise
caution before performing the operations.

a. Modify the Cloud-Init configuration file.
Take CentOS 6.7 for example. Modify the following parameters:
users: 
  - name: root 
    lock_passwd: false 
  
disable_root: 0 
ssh_pwauth: 1
n Set the value of lock_passwd to false, indicating that user passwords are not

locked.
n disable_root specifies whether remote login using SSH as user root is

disabled. Set its value to 0, indicating that remote login is enabled. (In the
Cloud-Init configuration in some OSs, true indicates that remote login is
disabled and false indicates that remote login is enabled.)

n ssh_pwauth specifies whether login using the SSH password is supported. Set
its value to 1, indicating that login using the SSH password is supported.

b. Run the following command to open /etc/ssh/sshd_config in the vi editor:
vi /etc/ssh/sshd_config
Change the value of PasswordAuthentication to yes.

NOTE

l For SUSE and OpenSUSE, change the values of both PasswordAuthentication and
ChallengeResponseAuthentication to yes.

l For Ubuntu, change the value of PermitRootLogin to yes.

c. Modify the shadow file and lock the initial password of user root in the image plate
to prevent security risks:
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i. Run the following command to open the /etc/shadow file in the vim editor:

vim /etc/shadow
Add !! to the hash value of the user root password. The modified file content
is as follows:
# cat /etc/shadow | grep root 
 root:!!$6$SphQRPXu$Nvg6izXbhDPrcY3j1vRiHaQFVRpNiV3HD/
bjDgnZrACOWPXwJahx78iaut1IigIUrwavVGSYQ1JOIw.rDlVh7.:17376:0:99999:7:
::

ii. After the modification, press Esc and enter :wq to save and exit the file.

NOTE

For Ubuntu, you must delete the user created during the OS installation. For example,
if the created user is ubuntu, run the userdel -rf ubuntu command.

Modifying Configuration Item /etc/motd

By modifying this configuration item, you can enable the system to remind users of changing
the password when they log in to the BMS for the first time. This helps enhance the BMS
security. To modify this configuration item, perform the following operations:

1. Run the following command to open /etc/motd in the vi editor or create /etc/motd:

vi /etc/motd

NOTE

/etc/motd is the directory that stores the prompts displayed after login to Linux.

2. Press i to enter editing mode and add the following information to the end of the file:
Please update the password for root regularly and ensure the complexity of 
the password.

3. Press Esc and enter :wq to save the change the exit.

(Optional) Set the Password Validity Period
1. Run the following command to query the password validity period:

vi /etc/login.defs
The value of parameter PASS_MAX_DAYS indicates the password validity period.

2. Run the following command to change the value of parameter PASS_MAX_DAYS:

chage -M 99999 user_name
99999 is the validity period of the password, and user_name is a system user.

You are advised to set the password validity period as needed and change it on a regular
basis.

3. Run vi /etc/login.defs to verify that the configuration has taken effect.
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3.15 Configuring Remote Login to a BMS
To enable remote login to a BMS, you need to configure the OS to ensure that the OS can be
displayed on the serial port. This section provides guidance for the administrator on how to
configure the serial port when creating a BMS image so that tenants can log in to the BMS
remotely. The configuration varies depending on the OS.

3.15.1 Oracle Linux 7.3, Oracle Linux 7.4, Red Hat 7, CentOS 7.2,
and CentOS 7.4

NOTE

The configuration files in this section are based on CentOS 7.2. Configuration files of other types of OSs
may be different.

1. Use the vi editor to open the /etc/sysconfig/grub file and add console=tty0
console=ttyS0 after GRUB_CMDLINE_LINUX.
GRUB_TIMEOUT=5
GRUB_DISTRIBUTOR="$(sed 's, release .*$,,g' /etc/system-release)"
GRUB_DEFAULT=saved
GRUB_DISABLE_SUBMENU=true
GRUB_TERMINAL_OUTPUT="console"
GRUB_CMDLINE_LINUX="crashkernel=auto rhgb quiet console=tty0 console=ttyS0"
GRUB_DISABLE_RECOVERY="true"
~
~

2. Run the following commands to update the configuration:
stty -F /dev/ttyS0 speed 115200
grub2-mkconfig -o /boot/grub2/grub.cfg
systemctl enable getty@ttyS0

3. To enable user root to log in to the BMS through the serial port, add ttyS0 to the end of
the security configuration file /etc/securetty.
vc/1
...
vc/9
vc/10
vc/11
tty1
...
tty9
tty10
tty11
ttyS0
"securetty" 39L, 221C

3.15.2 Oracle Linux 6, Red Hat 6, and CentOS 6
NOTE

The figures in this section show the configuration file of Red Hat 6.7. Configuration files of other types
of OSs may be different.

1. Use the vi editor to open the /boot /grub/grub.conf file, locate hiddenmenu, and add
the following information:
serial --unit=0 --speed=115200
terminal --timeout=5 serial console
Then add the following information to the end of the kernel row:
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console=tty0 console=ttyS0,115200n8

2. To enable user root to log in to the BMS through the serial port, add ttyS0 to the end of
the security configuration file /etc/securetty.

3.15.3 SUSE 11 SP4
1. Use the vi editor to open the /etc/inittab file and add S0:12345:respawn:/sbin/agetty -L

115200 ttyS0 to the end of the file.
2. Use the vi editor to open the /boot/grub/menu.lst file, locate hiddenmenu, and add the

following information to the end of the gfxmenu (hd0,1)/boot/message:
serial --unit=0 --speed=115200
terminal --timeout=5 serial console
Then add the following information to the end of the kernel row:
console=tty0 console=ttyS0,115200n8

3. To enable user root to log in to the BMS through the serial port, add ttyS0 to the end of
the security configuration file /etc/securetty.

3.15.4 CentOS 7.4 for ARM
1. Use the vi editor to open the /boot/efi/EFI/centos file, locate the line linux /

vmlinuz-4.11.0-22.el7a.aarch64 root=/dev/mapper/cla-root ro crashkernel=auto
rd.lvm.lv=cla/root rd.lvm.lv=cla/swap LANG=en_US.UTF-8, and add the following
information to its end:
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console=tty0 console=ttyAMA0,115200
2. To enable login through the serial port as user root, check whether the /etc/securetty file

contains ttyAMA0. If not, add it.

3.15.5 SUSE 12, CentOS 7.3, EulerOS 2.2 and Oracle Linux 7.2
NOTE

The configuration files in this section are based on SUSE 12 SP1. Configuration files of other types of
OSs may be different.

1. Use the vi editor to open the /etc/default/grub file and add console=tty0 console=ttyS0
after GRUB_CMDLINE_LINUX.

2. Run the following commands to update the configuration:
stty -F /dev/ttyS0 speed 115200
grub2-mkconfig -o /boot/grub2/grub.cfg
systemctl enable serial-getty@ttyS0

3. To enable user root to log in to the BMS through the serial port, add ttyS0 to the end of
the security configuration file /etc/securetty.

3.15.6 EulerOS-ARM64 2.2
1. Use the vi editor to open the /boot/EFI/grub2/grub.cfg file, locate linux/

vmlinuz-4.1.43-vhulk1708.1.1.aarch64 root=/, and add the following information:
console=tty0 console=ttyAMA0,115200

2. To enable user root to log in to the BMS through the serial port, check whether
ttyAMA0 is contained in the security configuration file /etc/securetty. If not, add it.

3.15.7 Ubuntu 16.04
1. Use the vi editor to open the /etc/default/grub file and add console=tty0 console=ttyS0

after GRUB_CMDLINE_LINUX.
2. Run the following commands to update the configuration:

stty -F /dev/ttyS0 speed 115200
grub-mkconfig -o /boot/grub/grub.cfg
systemctl enable getty@ttyS0

3. To enable user root to log in to the BMS through the serial port, add ttyS0 to the end of
the security configuration file /etc/securetty.

3.15.8 Ubuntu 16.04 for ARM
1. Use the vi editor to open the /etc/default/grub file and modify the following parameters:

– GRUB_CMDLINE_LINUX: console=tty0 console=ttyAMA0,115200
– GRUB_TERMINAL: serial
– GRUB_SERIAL_COMMAND: serial --speed=115200 --unit=0 --word=8 --

parity=no --stop=1
After modification, run the following command:
sudo update-grub2

2. To enable user root to log in to the BMS through the serial port, add the following
information to the end of the security configuration file /etc/securetty.
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For x86, check whether the file contains ttyS0. If not, add it.
For ARM 64, check whether the file contains ttyAMA0. If not, add it.

3.15.9 Ubuntu 14.04
1. Use the vi editor to open the /etc/default/grub file and add console=tty0 console=ttyS0

after GRUB_CMDLINE_LINUX.
2. Run the following commands to update the configuration:

stty -F /dev/ttyS0 speed 115200
grub-mkconfig -o /boot/grub/grub.cfg

3. Create /etc/init/ttyS0.conf and use the vi editor to modify its content as follows:
start on stopped rc RUNLEVEL=[12345]
stop on runlevel [!12345]
respawn
exec /sbin/getty -L 115200 ttyS0 vt102

4. Run the following command to start ttyS0:
sudo start ttyS0

5. To enable user root to log in to the BMS through the serial port, add ttyS0 to the end of
the security configuration file /etc/securetty.

3.16 Configuring the Root Partition to Automatically
Expand Disk Capacity

After the growpart package is installed for the image OS, the root partition of the BMS
provisioned using the image can automatically expand disk capacity. SUSE OSs have
growpart by default. However, the growpart version of SUSE 11 SP4 is too late, and you must
install growpart of an earlier version. Ubuntu OSs have growpart by default and the growpart
version meets requirements.

3.16.1 CentOS 6 and Red Hat 6
NOTE

For CentOS 6 and Red Hat 6, you must install three packages to enable the root partition to
automatically expand disk capacity: Cloud-Init, cloud-utils-growpart, and dracut-modules-growroot.
Cloud-Init has been installed in section Installing Cloud-Init.

This section uses CentOS 6.9 as an example to describe how to install the packages. The procedure also
applies to other OSs.

1. Check whether Cloud-Init, cloud-utils-growpart, and dracut-modules-growroot are
installed. If not, perform subsequent operations in this section to install them.
[root@localhost ~]# rpm -qa | grep cloud-init
cloud-init-0.7.5-10.el6.centos.2.x86_64
[root@localhost ~]# rpm -qa | grep growpart
[root@localhost ~]# rpm -qa | grep growroot
[root@localhost ~]#

2. Download the cloud-utils-growpart package from https://dl.fedoraproject.org/pub/
epel/6Server/x86_64/Packages/c/. Then upload it to the VM by following the
instructions in chapter 8.

3. Run the following command to install the cloud-utils-growpart package:
rpm -ivh cloud-utils-growpart-0.27-10.el6.x86_64.rpm
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[root@localhost redhat]# rpm -ivh cloud-utils-growpart-0.27-10.el6.x86_64.rpm
Preparing...                 ############################### [100%]
   1:cloud-utils-growpart    ############################### [100%]
[root@localhost redhat]#

4. Install the dracut-modules-growroot package.

a. Run the following command:
yum install -y http://dl.Fedoraproject.org/pub/epel/6/x86_64/epel-
release-6-8.noarch.rpm

b. Run the yum install dracut-modules-growroot command to install the dracut-
modules-growroot package online.
If message Is this ok [y/N] is displayed, enter y.

c. After the installation is successful, run the dracut -f command to update the kernel.
5. Run the commands in step 1 to check whether Cloud-Init, cloud-utils-growpart, and

dracut-modules-growroot have been installed successfully.

3.16.2 CentOS 7 and Red Hat 7
NOTE

CentOS 7 and Red Hat 7 use the 3.10 kernel (later than 3.8), and the dracut-modules-growroot package
is not required. You only need to install Cloud-Init and cloud-utils-growpart. Cloud-Init has been
installed in section Installing Cloud-Init.
This section uses CentOS 7.3 as an example to describe how to install the packages. The procedure also
applies to other OSs.

1. Check whether Cloud-Init and cloud-utils-growpart are installed. If not, perform
subsequent operations in this section to install them.
[root@localhost ~]# rpm -qa | grep cloud-init
cloud-init-0.7.5-10.el7.centos.1.x86_64
[root@localhost ~]# rpm -qa | grep growpart
[root@localhost ~]# 

2. Run the following command to install cloud-utils-growpart:
yum install cloud-utils-growpart

3. After the installation is complete, check whether the installation is successful.
[root@localhost ~]# rpm -qa | grep growpart
cloud-utils-growpart-0.29-2.el7.noarch

3.16.3 EulerOS 2.2
NOTE

For EulerOS 2.2, dracut-modules-growroot is not required and you only need to install Cloud-Init and
cloud-utils-growpart. Cloud-Init has been installed in section Installing Cloud-Init.

1. Check whether Cloud-Init and cloud-utils-growpart are installed. If not, perform
subsequent operations in this section to install them.
[root@localhost ~]# rpm -qa | grep cloud-init
cloud-init-0.7.6-3.x86_64
[root@localhost ~]# rpm -qa | grep growpart
[root@localhost ~]#

2. Download the cloud-utils-growpart package from http://developer.huawei.com/ict/site-
euleros/euleros/repo/yum/2.2/os/x86_64/Packages/. Then upload it to the VM by
following the instructions in chapter 8.

3. Run the following command to install the cloud-utils-growpart package:
rpm -ivh cloud-utils-growpart-0.27-10.x86_64.rpm
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[root@bms-eulor22 home]# rpm -ivh cloud-utils-growpart-0.27-10.x86_64.rpm
Preparing...                          ############################### [100%]  
Updating / installing...
   1:cloud-utils-growpart-0.27-10     ############################### [100%]

4. Run the command in step 1 to check whether the cloud-utils-growpart package has been
installed.
[root@localhost ~]# rpm -qa | grep growpart
cloud-utils-growpart-0.27-10.x86_64

3.16.4 SUSE 11 SP4
NOTE

SUSE OSs have growpart by default. However, the growpart version of SUSE 11 SP4 is too late, and
you must install growpart of an earlier version.

1. Run the following commands to check whether Cloud-Init and cloud-utils-growpart are
installed and check the version of cloud-utils-growpart.
linux-dann:~ # rpm -qa | grep cloud-init
cloud-init-0.7.6-32.8
linux-dann:~ # rpm -qa | grep growpart
growpart-0.29-7.1

2. Download the cloud-utils-growpart package from https://software.opensuse.org//
download.html?project=home%3Agarloff%3AOTC
%3Acloudinit&package=growpart. Then upload it to the VM by following the
instructions in section Installing Cloud-Init.

3. Run the following command to forcibly install the cloud-utils-growpart package:

rpm -ivh growpart-0.27-1.1.noarch.rpm  --force
linux-dam:/home/bms/bms # rpm -ivh growpart-0.27-1.1.noarch.rpm  --force
warning: growpart-0.27-1.1.noarch.rpm: Header V3 RSA/SHA1 signature: NOKEY, 
key ID de665020
Preparing...                     ############################### [100%]
   1:growpart                    ############################### [100%]

4. After the installation is successful, upload the original cloud-utils-growpart version.
linux-dann:/home/bms/bms # rpm -e growpart-0.29-7.1
linux-dann:/home/bms/bms #

5. Delete configuration item growpart from the /etc/cloud/cloud.cfg file.

Run the vi /etc/cloud/cloud.cfg command to delete configuration item growpart shown
in the following location.
datasource_list: [ openstack ]
growpart:
   mode: false
# The modules that run in the 'init' stage
cloud_init_modules:
 - migrator
 - bootcmd
 - write-files
 - growpart

3.17 Deleting Files

Deleting Uploaded Files

Delete files that have been uploaded to the VM, such as the rpm software packages of bms-
network-config and the SDI card driver.
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Deleting Temporary Files
l Run the following commands to delete temporary files:

rm -rf /var/log/cloud-init*
rm -rf /var/lib/cloud/*
rm -rf /var/log/network-config.log

l Run the following commands to delete the remaining configuration information:
– For SUSE OS:

Check which files start with ifcfg under the /etc/sysconfig/network/ folder, and
delete files starting with ifcfg other than ifcfg-lo.
The command to view the file: ll /etc/sysconfig/network/
The command to delete the file: rm -rf /etc/sysconfig/network/ifcfgxxx

– For RedHat, CentOS, Oracle and Euler OS:
Check which files start with ifcfg under the /etc/sysconfig/network-scripts/ folder,
and delete files starting with ifcfg other than ifcfg-lo.
The command to view the file: ll /etc/sysconfig/network-scripts/
The command to delete the file: rm -rf /etc/sysconfig/network-scripts/ifcfgxxx

– For Ubuntu OS: rm -rf /etc/network/interfaces.d/50-cloud-init.cfg
l Run the following commands to delete historical operation records:

history -w;echo > /root/.bash_history;history-c;history -c;history -c;
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4 Creating a Windows Image

4.1 Preparing Required Hardware and Software
Obtain a Linux physical server or virtual machine used for creating the image. This is the
host.

The host must have the followings installed:

l vsftpd service
l sshd service
l VNC service
l virt-manager tool
l KVM virtualization software

NOTE

You can download virt-manager from its official website or select it from the OS installation package.

Table 4-1 lists the required software.

Table 4-1 Required software

Software Description How to Obtain

Host ISO image CentOS 7.x You are advised to obtain it
from the official website.

OS ISO file ISO file used for creating an
image. The OSs supported by
BMS image are shown in Table
1-1.

You are advised to obtain
the ISO file from the OS
official website.

bms-network-config
network configuration
software package

Used for automatic network
configuration

Obtain it from the following
OBS bucket:
https://bms-image-
package.obs.myhwclouds.
com/bms-network-
config-1.0.8.zip
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NOTE

The memory of the BMS must be at least 150 MB larger than that of the created image. Ensure that the
created image meets this requirement.

Table 4-2 lists the required tools.

Table 4-2 Required tools

Tool Description How to Obtain

A tool for remote
access across platforms

Used for accessing the host
during image creation, such as
Xshell

You are advised to obtain it
from the official website.

File transfer tool Used for transferring files to the
VM during image creation, such
as Xftp

You are advised to obtain it
from the official website.

VNC tool Used for logging in to the VM
during image creation, such as
VNC Viewer
NOTE

If VNC Viewer is the 5.3.2 version,
choose Options > Expert >
ColorLevel on the login page and
set ColorLevel to rgb222.
Otherwise, you may fail to connect
to the remote OS.

You are advised to obtain it
from the official website.

 

4.2 Installing the Driver
The Windows chipset driver and V5 server driver are injected into the ISO image file for
installation, which is different from the installation methods of other drivers, such as the SDI
card driver. Therefore, you must perform operations in this section before those in section
Creating a VM.

Preparations
1. Prepare an ISO image file matching the Windows version.
2. Install Dism++.
3. Download the .zip package of the driver.

Log in at http://support.huawei.com/enterprise/en/index.html and choose Support >
Servers > Rack Servers > 2288H V5 > Software Download > 2288H V5
V100R005C00SPC112. Select the driver package based on the image OS.
– CentOS: FusionServer iDriver-CentOS-Driver-V327.zip
– Red Hat Enterprise Linux: FusionServer iDriver-Rhel-Driver-V329.zip
– Windows: FusionServer iDriver-Windows-Driver-V330.zip
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Take Windows Server as an example. Download FusionServer iDriver-Windows-
Driver-V330.zip.

4. Decompress the downloaded .zip package and obtain the ISO driver file.
After decompressing the .zip package, enter the Windows-Driver-V329 folder which
contains folders Windows 2012 and Windows 2016.
– Windows 2012: Obtain onboard_driver_win2k12r2.iso from the win2k12R2

folder.
– Windows 2016: Obtain onboard_driver_win2k16.iso from the win2k16 folder.

4.2.1 Installing the Chipset Driver

Scenarios
Chipset is a mainboard driver for Windows. If this driver is not installed, other hardware
drivers may be undermined in performance or even fail to work properly.

NOTE

Chipset can only be installed for Windows Server 2012 and Windows Server 2016. This section uses
Windows Server 2016 as an example. You can install chipset for Windows Server 2012 using the same
method.

Procedure
1. Decompress onboard_driver_win2k16.iso in section Preparations and obtain

SetupChipset.exe from folder chipset_10.1.2.86_public.
2. Convert the chipset installation package into a folder.

a. Click Start, enter cmd in Search programs and files, and press Enter.
b. Enter the directory where the chipset installation package is installed, for example,

D:\windows2016\tmp.
D:\windows2016\tmp>dir
2018/04/08    17:25    <DIR>          .
2018/04/08    17:25    <DIR>          ..
2018/03/08    15:14    <DIR>          drivers1
2018/03/08    11:28         3,525,008 SetupChipset.exe

D:\windows2016\tmp>
c. Run the following command to generate a folder named driver:

.\SetupChipset.exe -extract driver
D:\windows2016\tmp>.\SetupChipset.exe -extract driver

D:\windows2016\tmp>dir
2018/04/08    17:32    <DIR>          .
2018/04/08    17:32    <DIR>          ..
2018/04/08    17:32    <DIR>          driver
2018/03/08    15:14    <DIR>          drivers1
2018/03/08    11:28         3,525,008 SetupChipset.exe

D:\windows2016\tmp>
3. Decompress the Windows 2016 ISO image file in a folder.
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4. Start Dism and mount the image.

a. On the Dism page, choose File > Mount Image.
b. On the Mount Image page, perform the operations indicated in the following

figure.

1: After this operation is complete, select the other image from the drop-down list
and perform the operation again.
2: Select boot.wim in the sources folder in step 3.
3: Select an empty file, such as tmp1.
Click OK. The message Mounting is displayed.

c. After the status changes to Ready, click Open session.
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d. Perform the operations indicated in the following figure.

1: In the navigation pane on the left, choose Drivers.
2: Select Display in-box driver.
3: Select System Equipment.
4: Click Add.

e. Select the folder obtained in step 2.
The following dialog box is displayed.
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5. Save the added driver and unmount the image.

a. Choose File > Save Image. In the displayed dialog box, select Direct save.

b. Wait for the status to change from Saving to Ready.

c. Choose File > Unmount Image.

6. Mount the image again.

a. On the Dism page, choose File > Mount.

b. On the Mount Image page, perform the operations indicated in the following
figure.

1: By default, the Windows Server 2016 standard image is selected. You can also
select other versions from the drop-down list as needed.

2: Select boot.wim in the sources folder in step 3.

3: Select an empty file, such as tmp1.

c. After the status changes to Ready, click Open session.

d. Add the driver based on steps 4.d to 4.e.

7. Generate the ISO image.

Perform the following operations indicated in the following figure.
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1: Click Toolkit.
2: Select ISO Maker.

3: Select the directory where the original ISO image is decompressed.

4: Select the directory where the new ISO image is generated.

5: Click OK.

4.2.2 Installing the V5 Server Driver

Scenarios

This section describes how to install the X722 NIC driver so that BMSs can be provisioned on
V5 servers. Skip this section for other types of servers.

NOTE

The V5 server driver can only be installed for Windows Server 2012 and Windows Server 2016. This
section uses Windows Server 2012 as an example. You can install the V5 server driver for Windows
Server 2016 using the same method.

Procedure
1. Extract file

I350&X540&X550&82599&X710&XL710&X722_win2k12r2_x86_64_v22.7.1\PRO
40GB\Winx64\NDIS64 from the onboard_driver_win2k12r2.iso file in section
Preparations.

2. Mount the image. For details, see step 4 in section Installing the Chipset Driver.

3. Add the driver in the NDIS64 folder, save the change, and unmount the image. For
details, see step 5 in section Installing the Chipset Driver.

4. Mount the image again. For details, see step 6 in section Installing the Chipset Driver.
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5. Generate the ISO image and use it to create a Windows image. For details, see step 7 in
section Installing the Chipset Driver.

4.3 Creating a VM
This section describes how to create a Windows Server 2012 VM using virt-manager. The
methods of create VMs running other types of OSs are similar to this method. The following
figures and steps are for reference only.

1. Log in to the server used to create an image and start virt-manager.
[root@localhost Desktop]# virt-manager
[root@localhost Desktop]# 

2. Create a VM and select Local install media (ISO image or CDROM). Click Forward.
3. Select the ISO image file in the resource pool and select the OS type and version.

4. Configure the memory and CPUs of the VM Windows OS.
– Memory (RAM): 4096 MiB
– CPUs: 4

5. Configure the size of the disk image. Do not set a too large value. Otherwise, the
generated image will be too large.
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6. Click Manage and select a storage path, for example, /var/lib/libvirt/images.

Click , set Name (suffix .img is recommended so that the image can be
decompressed if it is large) and select raw (recommended) for Format.
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Click Finish. In the displayed storage volume list, select the created storage volume and
click Choose Volume.

7. Select Customize Configuration before install.
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8. Configure the NIC, select e1000 for Device model, and click Apply.

9. Click Begin Installation.
10. Install Windows.

Bare Metal Server
Private Image Creation Guide 4 Creating a Windows Image

Issue 01 (2018-05-15) 90



Select the installation language, time and currency format, and activate Windows Server
2012 using the product key you have purchased. Set other parameters based on
requirements.

4.4 Configuring the VM Environment
After Windows is installed, disable the firewall and configure remote desktop startup.

Windows Server 2012 and Windows Server 2016

1. Click  in the lower left corner to start Server Manager.

2. In the navigation pane on the left, choose Local Server. In the right pane, click the link
following Windows Firewall.

3. In the Windows Firewall window, choose Turn Windows Firewall on or off in the
navigation pane on the left.

4. In the Customize Settings window, turn off the Windows firewall for the private and
public networks.

5. Go back to the Local Server page and click the link following Remote Desktop.

6. In the System Properties window, select the options shown in the red box in the
following figure.
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7. Go back to the Local Server page and verify that the statuses of the properties are those
shown in the red box in the following figure

Windows Server 1709
1. Enter regedit in the command line to open the registry.
2. Disable the firewall.

a. In the Registry Editor window, choose HKEY_LOCAL_MACHINE >
SYSTEM > CurrentControlSet > Services > SharedAccess > Parameters >
FirewallPolicy > StandardProfile and set EnableFirewall to 0.

b. Choose HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet >
Services > SharedAccess > Parameters > FirewallPolicy > DomainProfile and
set EnableFirewall to 0.

c. Choose HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet >
Services > SharedAccess > Parameters > FirewallPolicy > PublicProfile and set
EnableFirewall to 0.

3. Enable remote connections.
In the Registry Editor window, choose HKEY_LOCAL_MACHINE > SYSTEM >
CurrentControlSet > Control > Terminal Server and set fDenyTSConnections to 0.

4.5 Installing Cloudbase-Init

4.5.1 Windows Server 2012 and Windows Server 2016
1. Download Cloudbase-Init from https://cloudbase.it/cloudbase-init/#download.
2. Upload the Cloudbase-Init installation package to the host and generate an ISO image.

Upload the installation package to the host.
[root@server nl]# ll
total 4390172
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-rw-r--r--. 1 root root    41070592  Sep 26 07:33 
CloudbaseInitSetup_0_9_11_x64.msi
-rw-r--r--. 1 qemu qemu  4413020160  Sep 26 02:36 
cn_windows_server_2012_r2_x64_dvd_2707961.iso
Run the following command in the directory where the installation package is stored:
mkisofs -L -R -J -T -V system-sp2 -o software.iso
CloudbaseInitSetup_0_9_11_x64.msi

3. Mount the generated ISO image to the VM and install Cloudbase-Init.

a. On virt-manager, choose View > Details.
b. In the navigation pane on the left, choose IDE CDROM 1 and click Disconnect in

the right pane.
c. Click Connect.
d. Select a local ISO file and click Open in the upper right corner.

e. Check the information and click Apply.
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4. Install Cloudbase-Init.
The following shows the default installation path of Cloudbase-Init.
C:\Program Files\Cloudbase Solutions\Cloudbase-Init

5. Edit the Cloudbase-Init configuration file in the C:\Program Files\Cloudbase Solutions
\Cloudbase-Init\conf directory as follows:

a. Create user administrator and add it to a group. Modify the following parameters:
username=Administrator
groups=Administrators

b. Configure hostname and modify the following parameter (if it does not exist, add
it):
netbios_host_name_compatibility=false

c. Locate and modify logging_serial_port_settings as follows:
logging_serial_port_settings=COM1,115200,N,8

d. Add parameter metadata_services and configure the loaded services as follows:
metadata_services=cloudbaseinit.metadata.services.httpservice.HttpService
,cloudbaseinit.metadata.services.configdrive.ConfigDriveService

e. Add parameter plugins and configure the modules to be loaded. Separate different
modules with commas (,). The information in bold is the keyword of each module.
The following is an example of the Cloudbase-Init file content:
plugins=cloudbaseinit.plugins.common.localscripts.LocalScriptsPlugin,clou
dbaseinit.plugins.common.mtu.MTUPlugin,cloudbaseinit.plugins.windows.crea
teuser.CreateUserPlugin,cloudbaseinit.plugins.common.setuserpassword.SetU
serPasswordPlugin,cloudbaseinit.plugins.common.sshpublickeys.SetUserSSHPu
blicKeysPlugin,cloudbaseinit.plugins.common.sethostname.SetHostNamePlugin
,cloudbaseinit.plugins.windows.extendvolumes.ExtendVolumesPlugin,cloudbas
einit.plugins.common.userdata.UserDataPlugin,cloudbaseinit.plugins.window
s.winrmlistener.ConfigWinRMListenerPlugin,cloudbaseinit.plugins.windows.w
inrmcertificateauth.ConfigWinRMCertificateAuthPlugin,cloudbaseinit.plugin
s.windows.licensing.WindowsLicensingPlugin

Functions of the modules are as follows:
n LocalScriptsPlugin: sets the scripts.
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n MTUPlugin: sets the MTU network ports.
n CreateUserPlugin: creates a user.
n SetUserPasswordPlugin: sets the password.
n SetUserSSHPublicKeysPlugin: sets the private key.
n SetHostNamePlugin: sets the hostname.
n ExtendVolumesPlugin: partitions the disks.
n UserDataPlugin: injects user data.
n ConfigWinRMListenerPlugin: sets listening to remote login.
n ConfigWinRMCertificateAuthPlugin: sets remote login without the

password authentication.
n WindowsLicensingPlugin: activates window instances.

4.5.2 Windows Server 1709
1. Download Cloudbase-Init from https://cloudbase.it/cloudbase-init/#download.
2. Upload the Cloudbase-Init installation package to the host and generate an ISO image.

Upload the installation package to the host.
[root@server nl]# ll
total 4390172
-rw-r--r--. 1 root root    41070592  Sep 26 07:33 
CloudbaseInitSetup_0_9_11_x64.msi
-rw-r--r--. 1 qemu qemu  4413020160  Sep 26 02:36 
Run the following command in the directory where the installation package is stored:
mkisofs -L -R -J -T -V system-sp2 -o software.iso
CloudbaseInitSetup_0_9_11_x64.msi

3. Mount the generated ISO image to the VM and install Cloudbase-Init.

a. On virt-manager, choose View > Details.
b. In the navigation pane on the left, choose IDE CDROM 1 and click Disconnect in

the right pane.
c. Click Connect.
d. Select a local ISO file and click Open in the upper right corner.
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e. Check the information and click Apply.
4. Copy the CloudbaseInitSetup_0_9_11_x64.msi installation package to the drive C: of

the VM.

a. Enter the VM OS, click Start, enter cmd in the Search programs and files box,
and press Enter to open the command-line interface.

b. Enter D: and press Enter.
c. Run the xcopy CloudbaseInitSetup_0_9_11_x64.msi C:\ command to copy the

CloudbaseInitSetup_0_9_11_x64.msi installation package to the drive C: of the
VM.

5. Install Cloudbase-Init.

a. Enter C: and press Enter to enter drive C:.
b. Run the CloudbaseInitSetup_0_9_11_x64.msi command and press Enter to install

Cloudbase-Init.
The following shows the default installation path of Cloudbase-Init.
C:\Program Files\Cloudbase Solutions\Cloudbase-Init

6. Edit the Cloudbase-Init configuration file in the C:\Program Files\Cloudbase Solutions
\Cloudbase-Init\conf directory as follows:
For details, see step 5.

4.6 Installing the bms-network-config Software Package

4.6.1 Windows Server 2012 and Windows Server 2016
1. Download the bms-network-config installation package bms-network_config.rar.

Decompress the package and copy bms-network-config.conf to the C:\Program Files
\Cloudbase Solutions\Cloudbase-Init\LocalScripts\ directory.
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NOTE

The value of bsdtar_path in the bms-network-config.conf file is C:\Program Files\Cloudbase
Solutions\Cloudbase-Init\bin\bsdtar.exe by default. If Cloudbase-Init is not installed in the
default directory, set the value of bsdtar_path to the directory where bsdtar.exe is resides.

2. Use a text editor such as Notepad to open the Cloudbase-Init configuration file in the C:
\Program Files\Cloudbase Solutions\Cloudbase-Init\conf directory and check the
value of parameter local_scripts_path. Cloudbase-Init will execute the required scripts
in this directory.

3. Copy bms-network-config.py to the C:\Program Files\Cloudbase Solutions
\Cloudbase-Init\LocalScripts directory based on the value of parameter
local_scripts_path in the Cloudbase-Init configuration file. The default path of
Cloudbase-Init is recommended. If you store the script file in another directory, change
the value of parameter local_scripts_path in the Cloudbase-Init configuration file.

4.6.2 Windows Server 1709
Installing the bms-network-config Software Package

1. Download the bms-network-config installation package bms-network_config.rar.
Decompress the package and copy bms-network-config.conf to the C:\Program Files
\Cloudbase Solutions\Cloudbase-Init\LocalScripts\ directory.

a. Enter D: and press Enter.
b. Run the xcopy bms-network-config.conf "C:\Program Files\Cloudbase

Solutions\Cloudbase-Init\LocalScripts"\ command.

NOTE

You can press Tab to complete the command.
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NOTE

The value of bsdtar_path in the bms-network-config.conf file is C:\Program Files\Cloudbase
Solutions\Cloudbase-Init\bin\bsdtar.exe by default. If Cloudbase-Init is not installed in the
default directory, set the value of bsdtar_path to the directory where bsdtar.exe is resides.

2. Use a text editor such as Notepad to open the Cloudbase-Init configuration file in the C:
\Program Files\Cloudbase Solutions\Cloudbase-Init\conf directory and check the
value of parameter local_scripts_path. Cloudbase-Init will execute the required scripts
in this directory.

3. Copy bms-network-config.py to the C:\Program Files\Cloudbase Solutions
\Cloudbase-Init\LocalScripts directory based on the value of parameter
local_scripts_path in the Cloudbase-Init configuration file (use the same method in step
1). The default path of Cloudbase-Init is recommended. If you store the script file in
another directory, change the value of parameter local_scripts_path in the Cloudbase-
Init configuration file.

4.7 Installing the SDI Card Driver
To use FusionStorage Block, you must install the SDI card driver on the BMS OS.

If you do not need FusionStorage Block or the BMS does not have an SDI card, you can skip
this section.

NOTE

Currently, the SDI card driver can only be installed for Windows Server 2012.
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Prerequisites
l You have logged in to the VM.
l The SDI card driver (scsi_ep_front) has been uploaded to the VM.

NOTE

The scsi_ep_front must be version 2.0.2 or later.

l WDK has been installed.
WDK download path: http://download.microsoft.com/download/4/E/0/4E07EAAD-
E394-4EA8-B2B8-D46E46A409C5/wdk/wdksetup.exe

Procedure
1. Obtain the device manager devcon.exe from the WDK directory C:\Program Files

(x86)\Windows Kits\10\Tools\x64 and place devcon.exe in the same directory as the
SDI card driver.

2. Locate the EpScsiAdaper installation information file and obtain the PCI ID.

3. Open the command-line interface (CLI), switch to the directory where the SDI card
driver and installation tool are stored, and run the following command:
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devcon install EpScsiAdapter.inf "PCI\VEN_19E5&DEV_1610&SUBSYS_000119E5"

Use the actual PCI ID.
4. (Optional) Delete device nodes.

a. If the environment where you create an image does not have SDI card hardware, the
storage controller in the device manager has exceptions.

b. Oprn the CLI, switch to the directory where the SDI driver and devcon are stored,
and delete abnormal device nodes.
Run the devcon.exe find "PCI\VEN_19E5*" command to locate abnormal device
nodes.
Run the devcon.exe remove "@ROOT\SCSIADAPTER\0000" command to
delete the nodes.
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c. Restart the OS.

d. Check whether the exceptions in the storage controller are cleared.

4.8 (Optional) Installing the One-Click Password Reset
Plugin

To enable one-click password reset for BMSs created using an image, you are advised to
install the password reset plugin cloudResetPwdAgent.

Notes

You can decide whether to install cloudResetPwdAgent.

Prerequisites

A Windows VM must have larger than 600 MB remaining space and data can be written to its
drive C:.

4.8.1 Windows Server 2012 and Windows Server 2016

Install the Password Reset Plugin on a Windows VM

Step 1 Check whether cloudResetPwdAgent and cloudResetPwdUpdateAgent have been installed on
the VM. To check this, perform the following operations:
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Start the Task Manager and check whether cloudResetPwdAgent and
cloudResetPwdUpdateAgent are displayed on the Services page.

l If yes, no further action is required.
l If no, go to step Step 2.

Step 2 Download password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

NOTE

CloudResetPwdAgent can be automatically upgraded only if an EIP is bound to the BMS. You can also
download the upgrade package and upgrade CloudResetPwdAgent manually.

Download and decompress CloudResetPwdAgent.zip.

Download path: http://bms-image-package.obs.myhwclouds.com/windows/reset_pwd_agent/
CloudResetPwdAgent.zip

Step 3 Install password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

1. Place the files extracted in Step 2 in the same directory of the VM (otherwise, the
installation will fail).

NOTE

There is no special requirement for the directory. You only need to ensure that the extracted files
are in the same directory.

2. Double-click the setup.bat file in the CloudResetPwdUpdateAgent.Windows
directory.
Install the password reset plugins.

3. View the Task Manager to check whether the installation is successful.
If you can find cloudResetPwdAgent and cloudResetPwdUpdateAgent in the Task
Manager, the installation is successful. Otherwise, the installation fails.
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NOTE

If the installation fails, check whether the installation environment meets requirements and install
the plugin again.

----End

Uninstall the Password Reset Plugin from a Windows VM
1. Log in to the VM and go to the C:\CloudResetPwdUpdateAgent\bin directory.
2. Double-click UninstallApp-NT.bat.
3. Delete C:\CloudResetPwdUpdateAgent.
4. Go to the C:\CloudResetPwdAgent\bi directory.
5. Double-click UninstallApp-NT.bat.
6. Delete C:\CloudResetPwdAgent.

4.8.2 Windows Server 1709

Install the Password Reset Plugin on a Windows VM

Step 1 Check whether cloudResetPwdAgent and cloudResetPwdUpdateAgent have been installed on
the VM. To check this, perform the following operations:

Start the Task Manager and check whether cloudResetPwdAgent and
cloudResetPwdUpdateAgent are displayed on the Services page.

l If yes, no further action is required.
l If no, go to step Step 2.

Step 2 Download password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

NOTE

CloudResetPwdAgent can be automatically upgraded only if an EIP is bound to the BMS. You can also
download the upgrade package and upgrade CloudResetPwdAgent manually.
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Download and decompress CloudResetPwdAgent.zip.

Download path: http://bms-image-package.obs.myhwclouds.com/windows/reset_pwd_agent/
CloudResetPwdAgent.zip

Step 3 Install password reset plugins CloudResetPwdAgent and CloudResetPwdUpdateAgent.

1. Upload folders CloudResetPwdAgent.Windows and
CloudResetPwdUpdateAgent.Windows obtained in Step 2 to the host and create ISO
image files using them.
[root@server404ee25c-9b2d-40ab-94b6-b89458db3004 cp]# ll
total 0
drwxr-xr-x. 3 root root 49 Jan 15 08:46 CloudResetPwdAgent.Windows
drwxr-xr-x. 3 root root 55 Jan 15 08:46 CloudResetPwdUpdateAgent.Windows
[root@server404ee25c-9b2d-40ab-94b6-b89458db3004 cp]# mkisofs -L -R -J -T -V 
system-sp2 -o software1.iso CloudResetPwdAgent.Windows
Run the following commands to create ISO image files using the folders:
mkisofs -L -R -J -T -V system-sp2 -o software1.iso CloudResetPwdAgent.Windows
mkisofs -L -R -J -T -V system-sp2 -o software2.iso
CloudResetPwdUpdateAgent.Windows

2. Mount the generated ISO image files to the VM (mount software1.iso first).

a. On virt-manager, choose View > Details.
b. In the navigation pane on the left, choose IDE CDROM 1 and click Disconnect in

the right pane.
c. Click Connect.
d. Select a local ISO file and click Open in the upper right corner.

e. Check the information and click Apply.
3. Run the mkdir CloudResetPwdAgent.Windows command to create folder

CloudResetPwdAgent.Windows in drive C:.
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4. Run the following command to copy the ISO image file mounted in step Step 3.2 to the
folder created in step Step 3.3:
xcopy /e /c /y D:\* C:\ CloudResetPwdAgent.Windows

5. Mount software2.iso to the VM using the same method in step Step 3.2.
6. Run the mkdir CloudResetPwdUpdateAgent.Windows command to create folder

CloudResetPwdUpdateAgent.Windows in drive C:.

NOTE

There is no special requirement on the VM directory where the files are stored. You only need to
ensure that CloudResetPwdAgent.Windows and CloudResetPwdUpdateAgent.Windows are
stored in the same directory.

7. Run the following command to copy the ISO image file mounted in step Step 3.5 to the
folder created in step Step 3.6.
xcopy /e /c /y D:\* C:\ CloudResetPwdUpdateAgent.Windows

8. Run setup.bat in the CloudResetPwdUpdateAgent.Windows directory.
Enter setup.bat and press Enter to start installing the password reset plugin.

9. View the Task Manager to check whether the installation is successful.
If you can find cloudResetPwdAgent and cloudResetPwdUpdateAgent in the Task
Manager, the installation is successful. Otherwise, the installation fails.

NOTE

If the installation fails, check whether the installation environment meets requirements and install
the plugin again.

----End

Uninstall the Password Reset Plugin from a Windows VM
1. Log in to the VM and go to the C:\CloudResetPwdUpdateAgent\bin directory.
2. Double-click UninstallApp-NT.bat.
3. Delete C:\CloudResetPwdUpdateAgent.
4. Go to the C:\CloudResetPwdAgent\bi directory.
5. Double-click UninstallApp-NT.bat.
6. Delete C:\CloudResetPwdAgent.

4.9 Configuring the SID
A Security Identifier (SID) is a unique value that identifies a user, group, or computer
account.

NOTE

Currently, only Windows Server 2016 requires SID during image creation. For how to configure a SID
for Windows Server 2012, see the Bare Metal Server User Guide.

1. Modify the Cloudbase-Init configuration files.

a. Open the cloudbase-init.conf and cloudbase-init-unattend.con files in the C:
\Program Files\Cloudbase Solutions\Cloudbase-Init\conf directory.

b. Add first_logon_behaviour=no to both files.
[DEFAULT]
username=Administrator
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groups=Administrators
first_logon_behaviour=no
netbios_host_name_compatibility=false
metadata_services=cloudbaseinit.metadata.services.httpser
inject_user_password=true
...

c. Delete cloudbaseinit.plugins.common.sethostname.SetHostNamePlugin from
the cloudbase-init-unattend.conf file.

2. Open the CLI and enter the following command to open the Sysprep window:
C:\Program Files\Cloudbase Solutions\Cloudbase-Init\conf>C:\Windows
\System32\Sysprep\sysprep.exe /unattend:Unattend.xml

3. Configure the parameters based on the following figure.

4.10 Setting Time Zone Calibration
Linux uses the time of the motherboard CMOS chip as the Coordinated Universal Time
(UTC) and determines the system time based on the configured time zone. However,
Windows uses the CMOS time as the system time directly without converting it based on the
time zone.

The following configuration is required:

1. Log in to the Windows VM.
2. Click Start, enter regedit in the Search programs and files text box, and press Enter.
3. In the displayed Registry Editor window, choose HKEY_LOCAL_MACHINE >

SYSTEM > CurrentControlSet > Control > TimeZoneInformation.
4. In the right pane, right-click a blank area and choose New > DWORD (32-bit) Value to

add a REG_DWORD code. Set its name to RealTimeIsUniversal and value to 1.

NOTE

If the image does not support mouse operation, right-click can be changed to press the menu key
on the keyboard, and then use the keyboard to operate.
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4.11 Setting Virtual Memory
NOTE

Only Windows Server 2012 and Windows Server 2016 need to set virtual memory.

The memory of the BMS is large, and automatically allocated virtual memory will take up a
lot of system disk space, affecting system performance. It is recommended to turn off the
virtual memory or set the ceiling during the mirroring process. Specific operations are as
follows:

1. Log in to the Windows VM.
2. Click Start. Right-click Computer and select Properties.

The System page is displayed.
3. In the navigation pane on the left, choose Advanced system settings.

The System Properties dialog box is displayed. By default, it is under the Advanced
tab.

4. In the Performance area, click Settings.
The Performance Options dialog box is displayed.

5. Click the Advanced tab and click Change in the Virtual memory area.
The Virtual Memory dialog box is displayed.

Figure 4-1 The Virtual Memory dialog box
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6. Remove check Automatically manage paging file size for all drives.
7. If you need to disable the virtual memory, select No paging file. If you need to set an

upper limit for the virtual memory, select Custom size. You are advised to set the
maximum size of the virtual memory to less than 2G.

8. Click Set.
9. Click OK.
10. Restart the OS to complete the virtual memory settings.

4.12 (Optional) Enabling Automatic Windows Update
Windows Server automatic update reminds you of downloading and installing important
updates on your PC. By default, you need to manually configure this function.

Windows Server 2012 and Windows Server 2016
1. Log in to the Windows VM.

2. Click  in the lower left corner and then Server Manager.
3. In the navigation pane on the left, choose Local Server. In the right pane, locate

Windows Update and click the link that follows it.
4. On the Windows Update page, click Install updates automatically.

NOTE

You can decide whether to enable this function. If you enable it, do not interrupt the Windows
update during the process, which may take some time.

Windows Server 1709
1. Log in to the Windows VM.
2. In the CLI, enter regedit to open the registry.
3. Modify registry entries.

– In the Registry Editor window, choose HKEY_LOCAL_MACHINE >
SOFTWARE > Policies > Microsoft > Windows > WindowsUpdate > AU and
add the following information:
[HKEY_LOCAL_MACHINE/SOFTWARE/Policies/Microsoft/Windows/WindowsUpdate/AU]
"NoAutoUpdate"=dword:00000000
"AUOptions"=dword:00000002
"ScheduledInstallDay"=dword:00000000
"UseWUServer"=dword:00000001

– In the Registry Editor window, choose HKEY_LOCAL_MACHINE >
SOFTWARE > Policies > Microsoft > Windows > WindowsUpdate and add the
following information:
[HKEY_LOCAL_MACHINE/SOFTWARE/Policies/Microsoft/Windows/WindowsUpdate]
"WUServer"="http://wsus.neu.edu.cn"
"WUStatusServer"="http://wsus.neu.edu.cn"
"TargetGroupEnabled"=dword:00000001
"TargetGroup"="reg"
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5 Stopping the VM and Obtaining the Image

Stopping the VM

You can run the sudo poweroff command in the OS to stop the VM. If it does not work, on
virt-manager, click Virtual Machine Manager, select the running VM shown in the red box
in the following figure, right-click it, and click shutdown (if the VM cannot be stopped, you
are advised to click Force Off).

Obtaining the Image

If you select automatic creation of the image disk, the QCOW2 or IMG image file is in
the /var/lib/libvirt/images directory.

Figure 5-1 Image file (Linux OS)

If you select manual creation of the image disk, obtain the image file from the directory where
it was created.

Decompressing the Image

If the created image file is too large, run the following command to decompress it:

qemu-img convert -f raw -O qcow2 SourceFile FinallyFile.qcow2

SourceFile format can be .img or qcow2.
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6 Converting the Image Format

Scenarios
Currently, only ZVHD images are supported. Convert images of other formats to ZVHD
images by performing the operations in this section.

Prerequisites
qemu-img-hw listed in Table 3-1 in section Preparing Required Hardware and Software is
available.

Procedure
1. Log in to the host and run the following command to set permissions:

chmod 777 qemu-img-hw
2. Run the following command to convert the format of an image:

./qemu-img-hw convert -p -f Source image format -O Target image format Source
image file Target image file
Source image format can be qcow2, raw, vhd, or zvhd, and Target image format must
be zvhd.
An example command is as follows:
[root]#./qemu-img-hw convert -p -f qcow2 -O zvhd Redhat73.qcow2 Redhat73.zvhd

Bare Metal Server
Private Image Creation Guide 6 Converting the Image Format

Issue 01 (2018-05-15) 110



7 Registering a Private Image

Scenarios

Users can create a BMS private image from an external image file and register the image on
the public cloud platform.

Prerequisites
l A private image has been created.
l The image file has been uploaded to the OBS bucket.

Procedure
1. Log in to the management console.

2. Click  in the upper left corner and select the region and project.
3. Under Computing, click Image Management Service.

The IMS console is displayed.
4. Click Create Private Image and configure the following parameters:

– Source: Select Image file.
– Image Type: Select BMS image.
– Image File: Click Select, select the OBS bucket that stores the image file to be

used, and select the image file.
– OS: (Optional) Select the OS of the image file. To ensure that the image can be

created and used properly, select the OS consistent with that of the image file.
– System Disk (GB): Set the system disk size.
– Name: Enter a name for the image to be created. The value can contain only letters,

digits, spaces, hyphens (-), and underscores (_), and cannot start or end with a
space.

– Tag: (Optional) Add a tag to the image to identify and manage the image more
easily.

– Description: (Optional) Enter description of the image.
5. Click Create Now.

On the displayed page, confirm the specifications and click Submit.
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NOTE

The time required for image registration is determined by the image file size. You may need to
wait a long period of time for the external image file to be successfully registered as a BMS image.

6. The page that contains private images is displayed. The private image is being created.
After its status changes to Normal, the image is registered successfully.
You can also check whether the image is contained in the private image drop-down list
on the Buy BMS page.
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8 FAQ

8.1 How Can I Set the Mode of Adjusting the BMS CPU
Frequency?

Common CPU frequency adjustment modes include performance, powersave, and
ondemand. You can select an appropriate one based on the BMS scenario.

To set the CPU frequency adjustment mode to performance, perform the following operations:

l Red Hat 6

Modify the following parameter in the /etc/sysconfig/cpuspeed file:
GOVERNOR=performance

l Red Hat 7

Modify the following parameter in the /etc/sysconfig/cpupower file:
CPUPOWER_START_OPTS="frequency-set -g performance"

l Debian Gnu/Linux 8

Modify the following parameter in the /etc/init.d/cpufrequtils file:
GOVERNOR="performance"

NOTE

l If you do not have relevant software, run the yum install xxx (software name) command or
download the RPM package to install the software.

l For Red Hat 6, to enable the intel_pstate driver to automatically load and make the configured
parameters take effect upon OS startup, you can configure a script.

1. Run the following command to create the intel_pstate.modules file:

vi /etc/sysconfig/modules/intel_pstate.modules

2. Add the following content:
/sbin/modprobe intel_pstate > /dev/null 2>&1

3. Press Esc and enter :wq! so save the configuration.

4. Run the following command to modify permissions of the file:

chmod 755 /etc/sysconfig/modules/intel_pstate.modules
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8.2 How Can I Handle the Failure of Data Injection into
the BMS Due to the Occasional Start Failure of cloud-init-
local?

Symptom
For Red Hat 7 and CentOS 7, cloud-init-local may fail to start. After you run systemctl status
cloud-init-local.service, the message "OSError: [Errno 2] No such file or directory" is
displayed. As a result, data cannot be injected into the BMS.

Solution
If Red Hat 7 and CentOS 7 has a libselinux module earlier than version 2.5.7, a known kernel
bug will occasionally cause cloud-init-local start failure (for details of the bug, see https://
bugzilla.redhat.com/show_bug.cgi?id=1406520). When creating a Red Hat 7 or CentOS 7
image, you are advised to upgrade libselinux to version 2.5.7 or later by following the
instructions in section Red Hat, CentOS, and Oracle Linux.

8.3 How Can I Activate a Windows BMS?
Perform the following operations to manually activate a Windows BMS:

1. Log in to the Windows BMS.
2. Click Start, enter cmd in Search programs and files, and press Enter to open the

command-line interface (CLI).
3. Run the following command to configure the IP address of the KMS server:

slmgr -skms 100.125.1.2
4. Run the following command to check whether the BMS has been activated:

slmgr -ato
If error 0xC004F074 occurs, the BMS cannot be activated. In such an event, go to step 5.

5. Verify that the time in the BMS is the same as the standard time. If the time is
significantly different, the BMS cannot be activated.

6. Run the following command on the BMS to check whether the link between the BMS
and the KMS server port is reachable:
telnet 100.125.1.2:1688
If the link is unreachable, port 1688 is not enabled on the BMS firewall. You must
disable the firewall or enable port 1688 on the firewall. If the BMS has any security
software such as safedog, stop using it.

7. Run the following command to check whether the BMS has been activated:
slmgr -ato
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A Appendix

A.1 Configuring the SSH Service
1. After Linux is installed on the host, open the Linux terminal and run the following

command to check the SSH service status:
service sshd status
In the command output, check whether the SSH service is enabled and whether its status
is active.
– If the SSH service is not enabled, run the service enable sshd command.
– If the SSH service status is not active, run the service sshd start command.

2. Modify the SSH service configuration file to enable user root to log in to the host using
SSH.
Configuration file path: /etc/ssh/sshd_config
Set the value of PermitRootLogin to yes.

A.2 Configuring the vsftpd Service
1. After Linux is installed on the host, open the Linux terminal and run the following

command to check the vsftpd service status:
service vsftpd status
In the command output, check whether the vsftpd service is enabled and whether its
status is active.
– If the vsftpd service is not enabled, run the service enable vsftpd command.
– If the vsftpd service status is not active, run the service vsftpd start command.

A.3 Configuring the VNC Service
1. Run the following command to check whether the VNC server is installed:

rpm -qa | grep tiger-server
The following information is displayed:
tigervnc-server-1.1.0-5.e16.x86_64

Bare Metal Server
Private Image Creation Guide A Appendix

Issue 01 (2018-05-15) 115



If the VNC server is not installed, no command output is displayed or the command
output shows that the VNC server is not installed. In this case, you need to install the
VNC server on the host. In many cases, this software is in the ISO image file and you
can use yum or Zypper to install it.

2. (Optional) Install tigervnc-server.

a. Run the lsblk command (the OS ISO file must be mounted to the BMC virtual CD-
ROM drive. If not, mount the ISO file in the same way as OS installation).

b. Locate the block device whose name is sr0 and type is rom, and check whether
directories are mounted to the mount point. If no, run the following command:
mount /dev/sr0 /mnt

c. Enter the /etc/yum.repos.d directory where the configuration is stored and back up
all .repo files. Use vim to create a .repo file, for example tiger.repo. The file
contains the following content:
[rhel-local]
baseurl=file:///mnt 
enabled=1 
gpgcheck=0
Save the file and run the following commands:
yum repolist
yum install tigervnc-server

3. Start the VNC service check whether the VNC server is installed:
vncserver
Configure the VNC login password of user root as prompted.
The command output contains the Log file is /root/.vnc/rhel:1.log information. 1
indicates that the current user is allocated the first VNC desktop.

4. Run the following command to check whether the Xvnc process exists:
ps -ef | grep Xvnc

The process ID is 36069, port number used is 5901, and virtual desktop number is 1.
5. Run the following command check whether the VNC server is installed:

vncserver -list

The current user has three virtual desktops, 1, 5, and 2.

Bare Metal Server
Private Image Creation Guide A Appendix

Issue 01 (2018-05-15) 116



6. Use a Windows client to connect to the VNC server to log in to the host.
When you install VNC Viewer for the first time, if the version of VNC Viewer is 5.3.2,
set ColorLevel to rgb222. To set it, choose Options > Expert > ColorLevel.

7. Run the following command check whether the VNC server is installed:
vncserver :6
Run the vncserver -list command to check whether the virtual desktop is added
successfully. If information shown in the following figure is displayed, the virtual
desktop 6 is added successfully.
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B Change History

Release Date Description

2018-05-15 This issue is the first official release.
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